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About This Guide

This section describes the purpose, audience, organization, and conventions that are used in
this iPECS UCS Client for PC User Guide

NOTE

The screen might look different depending on which version of the OS (Operating System) and
Installation Program you are using. All information in this guide is subject to change without
prior notice.

This guide introduces the IPECS UCS Client for PCs and explains how to correctly install and
use the UCS Client. The figures and screen images used in this guide may be changed
without notice

This guide provides user-related information intended for users of the PC-based UCS Client.

This guide consists of this ‘About This Guide’ section, 16 Chapters, as listed below.
* About This Guide

* Chapter 1: Introduction

* Chapter 2: Installation and Setup

* Chapter 3: General Description

* Chapter 4: Message & Status Bar

* Chapter 5: My Detail Information

* Chapter 6: Main Window Views

* Chapter 7: Quick Call Control Bar

* Chapter 8: Tools Menu Call Features
* Chapter 9: Scheduling Appointments

* Chapter 10: ICR (Individual Call Routing) Window Introduction
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* Chapter 11: Collaborative Session Tools
* Chapter 12: Supplementary Features

* Chapter 13: Call View & Call Control

* Chapter 14: Audio Conference Manager
* Chapter 15: Visual Voicemail

* Chapter 16: Useful Information
This section describes text formatting conventions and important notice formats used in this
guide.

Text formatting

The narrative-text formatting conventions that are used as follows:

Convention Description

Bold text Lnec:iecca;tes a button, menu item, or dialog box option you can click or
Italic text a cross-reference, or an important term

Code text a command prompt

P, S) indicates the applicable UCS license, Premium or Standard

(UCP, CM) indicates the iPECS platform (UCP or CM) that supports the function

Important notice

The following icons and notices are used in this guide to convey important cautions and notes.

CAUTION

A caution statement alerts you to situations that may cause damage to hardware, software, or
data.

NOTE

A note provides additional explanations, emphasis on important information, or a reference to
related information.
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Chapter 1
Introduction

This chapter is an overview of the UCS client.

The iPECS UCS (Unified Communications Solution) Client is a PC based application, which
operates in conjunction with the iPECS UC platform and UCS Server, expanding and
enhancing the communication services of IPECS to dramatically improve business productivity
and customer responsiveness.

In addition to the rich voice services available with the iPECS system, users of iPECS UCS
Client have access to a wide range of video, text, collaborative and messaging services.
Services available include Presence, Video Conferencing, Instant Messaging, Sharing
(Application, Desktop and Whiteboard), Individual Call Routing (ICR), and more.

Employing a simple intuitive graphical user interface, the UCS Client has access to both private
and shared scheduling and directory database applications, which are fully integrated with the
various services available in the iPECS UC platform and UCS Server. The UCS Client user
interface is highly flexible and can be customized to address the needs of the individual user.

Further, the UCS Client database applications can interoperate and synchronize with major
personal information management applications and databases such as Outlook, ACT!,
Goldmine, Excel and LDAP.

As an Internet Protocol (IP) solution, the UCS Client overcomes geographical limitations
allowing access to services and databases while in the office or on the road.
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Chapter 2

Installation and Setup

2.1.1

Installation and set-up of the IPECS UCS Client is a simple four-step process:

* Step 1: Verify your hardware and operating system
* Step 2: Install the iPECS UCS Client application on the user’s PC.
* Step 3: Adjust UCS Client login settings.

* Step 4: Login to complete registration of the IPECS UCS Client application to the iPECS
system and UCS Server.

Completing the login and registration process may require assistance from the iPECS
Administrator to adjust settings of the iPECS system and the UCS Server; both will require the
client User ID and Password. iPECS UCS Client will require entry of the host iPECS system
and UCS Server IP address.

Prior to installation, the PC and operating system should be verified for compatibility with the
iPECS UCS Client application. Assure that the PC and Operating System (OS) comply with the
minimum requirements of Section 2.1.

The UCS Client application software requires a PC with the minimum configuration defined
below.

PC Hardware:

* CPU: Intel Core2 Duo 2.8 or higher (Normal UCS Operation: Voice Call, Presence, IM, etc.)
Intel i3 or higher (Special UCS Operation: Point-to-Point 4CIF Video call)
Intel i5 or higher (Special UCS Operation: Multiparty Video call)

* RAM: 2 GB Bytes of DRAM (2GB required for 4CIF usage)

* Hard disk space: 200 M Bytes of HDD storage

* Monitor: 17” recommended, with a resolution of 1024 x 768

* LAN card : 100/1000 Base T NIC (Network Interface Card)

e CD ROM drive
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¢ Standard Keyboard and Mouse
* Web Cam for Video Conference (optional)
* Sound card and Microphone installed

* USB headset (recommended)

NOTE
Voice quality is highly dependent on the quality of the headset.

2.1.2 Operating System:

* Windows XP
* Windows Vista

* Windows 7

Prior to registration of iPECS UCS Clients with the host IPECS system and UCS Server, the
host iIPECS system will require installation of a UCS Client software license. The administrator
must enter a lock-key code in the iPECS system.

IPECS UCS employs a seat-based license scheme. In this scheme, the maximum number of
registered UCS Clients is set in the installed lock-key. For information on Lock-keys, contact the
local Ericsson-LG Enterprise distributor.

This section explains how to install the iPECS UCS Client. The software can be obtained by
download from the iPECS UCS Web Admin Download Client Program window or from the
iPECS UCS Client CD-ROM. Download from the iPECS UCS Web Admin may require
assistance of your iPECS Administrator.

2.3.1 To obtain the software by download:

1. Open a browser on the PC.

2. Point the browser to http://ip address of UCS Web Admin/UCS, your iPECS Administrator
should have the IP address.
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&~ (2 ey

< SHEI ‘? Welcome to Unified Cammunications Solution |_|

Welcome to Unified Communication Solution

Click to download UCS Client Pro: ramPL

s

Enaglish
administrator

Login

Password

Web Administration

3. Click the Click to download UCS Client Program link at the lower-left of the screen.

4. Select the Windows (PC) Download button. The Windows File Download Security screen

displays.

B D

Outlook Plugin[_Download ]

= This Plugin allows to make a call from
Outlook contact

Install Notes Inslall Motes

Jabra PC Suite[ Download |

= It allows for Jabra Headsets to be
compatible with UCS

Install Motes Inslall Motes

Plantronics[_Dewnload |

Install Motes

Install Motes
= It allows for Plantronics Headsets o be

compatible with UCS.

UC S Client

Fc)

Dawnload

7 are required
uuuuuuuu

= Windows 000 Vind

AT Windo s

WWindowi M/E5/H0 are not

(Mobile) [ Download |

Min Z00ME Fros HDD Space

Android (Mobile) [ Download |

= Windows Mobee 5.1 or 0.5 8 requred

miintion packags in optmized

Select Save to save the UCS Client application in the designated directory, or select Run to

install UCS client directly on the PC.

File Download - Security Warning

Do wou want ta run or save this file?

-

Marne: UCSClient.exe
Tepe: Application, 22.5 MB
From: 192.162.1.1

[ Run ] [ ] [ Cancel ]

Save

whhile files from the Internet can be uzeful, thiz file type can
potentially harm your computer. [f you do nat trust the source. do not
run or save this software. What's the risk?
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2.3.2 Toinstall the UCS Client application:

If “Run” was selected in step 5 above, the UCS Client Install Wizard appears. If “Save” was
selected; find and run the UCSClient.exe file received during download.

1. The UCS Client Install Wizard should appear, click Next to continue.

8 LICS Client - InstallShield Wizard 3]
Welcome to the InstallShield Wizard for UCS
Client

The Installshield(R) Wizard will install UCS Client on yaur
computer, To continue, click Next,

WARNING: This program is protected by copyright law and
international treaties.

2. The software License Agreement window appears. Read and accept the license terms, and
click Next.

UCS Client — InstallShield Wizard

UCS Client License Agreement

The aim of this contract is for deciding items about using service after &
install UCS client pragram distributed by LG-Mortel
1. The sole copyright for server and client pragram used in UGS
service belongs to LG-Mortel
2. Sewice coverage - UCS service means the service such as
voicedvideo call, presence, IM, collaboration etc between UCS y
server and UCS client program distributed by LG-Nortel
3. User wha installed this client program can use IM, presence,
voicedvideo call and collaboration functions supplied by UCS
SBrver. -

@ gccept the terms of the license agresment

2| do not aceept the terms of the license agreement

<Back || Mewt> | [ Cancel |

3. Inthe Customer Information window, enter your User Name and Organization; select the radial
button for all users or “Only for me” then click Next.

i UCS Client Install Package - InstallShield Wizard

Customer Information 1 b ]

Please enter your information.

LUser Marme:
frirn

Crganization:
[Eics sw]

Install this application For:
() anyone who uses this computer (all users)
(%) Oy For me (kim)

[ < Back H Mext = ] [ Cancel

4. Inthe Destination Folder window, you may either accept the default destination (C:\Program
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Files\UCS Client), which is recommended or select Browse to locate a different directory or
specify a directory. If you specify the directory, do not include spaces or special characters.

UCS Client - InstallShield Wizard

Destination Folder

Setup will install UCS Client in the following folder,

Toinstall to this folder, click Nest. To install ta a different folder, click Browse and select
another folder

Destination Folder

C:AProgram Files\UCS Clent

<Back || Mest> \[ Cancel ]

5. Click Next to install WinPcap 4.1.3. WinPcap is a-standard tool for link-layer network access in
the Windows environment. The WinPcap Installer is imbedded in the UCS Client Installer, and
opens automatically.

§ WinPcap 4.1.3 Setup g|§|@|

Welcome to the WinPcap 4.1.3
Setup Wizard

This Wizard will guide you through the entire WinPcap
installation,

For more information or support, please visit the WinPcap
home page.

http:/fwww.winpcap.org

Cancel

6. The WinPcap software License Agreement window appears. Read and click | Agree to
continue the installation. The WinPcap installer begins copying files onto your hard disk.

# WinPcap 4.1.3 Setup E“Elgl
K ‘) > License Agreement
Vv ln caP Please review the license terms before installing WinPcap 4.1.3.

Press Page Down to see the rest of the agreement.,

Copyright (c) 1993 - 2005 NetGroup, Politecnico di Torino (Ttaly). ~
(Copyright {c) 2005 - 2010 CACE Technologies, Davis (California).

Copyright {c) 2010 - 2013 Riverbed Technology, San Francisco {California).

Al rights reserved.

Redistribution and use in source and binary forms, with or without modification, are
permitted provided that the following conditions are met:

1. Redistributions of source code must retain the abave copyright notice, this list of
conditions and the following disclaimer.
2, R_Edlsmhuums in b_\nary form must repr_uduce the above :upy_'[lght notice, this _\lst of  |»

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install WinPcap 4.1.3.

[ <sacx [ ragee | [ cancel |

7 . After successful installation of WinPcap, click Finish to complete WinPcap installation.
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# WinPcap 4.1.3 Setup |Z“: :

Completing the WinPcap 4.1.3
Setup Wizard

WinPcap 4. 1.3 has been installed on your computer.

Click Finish to dose this wizard,

8. When all files have been downloaded, the Installation Completed window is shown, click Finish.
The iPECS UCS Client application can open automatically when Windows starts; click the box
for “Run UCS client automatically when Windows starts” to enable.

UCS Client - InstallShield Wizard
InstallShield Wizard Complete

Setup has finished installing UCS Client an your computer,

|DF\ un LICS client automatically when Windows starts:

< Back Cancel

2.4 Initial Setup and Login

To setup the UCS Client application, perform the following steps:

1. After installation, click on UCS Client from the Programs listing in the Windows Start menu or
click the desktop shortcut icon created during the software installation.

2. Once launched, the IPECS UCS Client Login screen will appear. For the initial installation, you
must define the IP address and other basic parameters for the iPECS system, UCS Server and
client in the General Setting window. Select Setting from the File menu, the Server Connection
window displays.
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(@ uCS Client

Login

File | view Tools

Open Received Files

Help

[ setting

Close

3. For UCS Server Connection, enter the IP Address of the UCS Server provided by your iPECS
Administrator, or if already shown, check Use Detected Server IP.

(7] Setting =
= Server Connection S
s J— ~BEX
= Basic Action
« Display UCS Server Connection |
= Sound
150.150.131.213
+ Outlook Intsgration [use Detected Server IP
= Call TP Address (3o, xxx. 300, X%
= Disling Rules
= Call Popup = Login Timeout 3000~9999(msec)
= Ring Sound
= Audio » Server Relay Mode () Auto () Enable (O Disable
= vaice Codec
= IP Bridge Call Server Connection
= Recording
oot T
= Functi
”f(F:‘“;”S = ConnectionMode (3 Aute O Local O Remate
= Sharing P License () standard (&) Premium
= ideo
- 1M Call Control bode (2 with Voice: O naoice
- LoaP
+ ideo Presentation ode Telnis Passwerd [ |
advenced | [ HetwerkDiagnostics |
0K Cancel Apply

* Select OK to save the new values.

4. When finished, login by entering your User ID and Password. Remember, the User ID and
Password are case sensitive.

[E1 ues Client ——

=

#User ID

* The User ID and Password may be 2-12 alphanumeric characters and the Password may
include symbol characters.

* In asingle user environment, use the Auto Login, Remember User ID and Password
checkboxes, to automate login to the IPECS system and UCS Server every time the UCS

iPECS UCS Client for PC User Guide - Issue 4.1



Client application is launched.

5. Click Login to initiate the IPECS UCS Server and system login; the UCS Client Console should
display.

NOTE

If no audio device is defined in the PC, a warning dialog is displayed and the UCS Client will not
open. With Windows 7 and Windows Vista, the warning message is also displayed if the audio
device is not connected. Clicking “Yes” in the Warning Dialog box will open UCS Client without
audio capabilities.

If the number of Login attempts reaches the threshold assigned by the UCS Server
administrator, the User account is locked. To unlock the account, either the administrator must
unlock the account or the assigned lockout duration timer must expire.
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Chapter 3
General Description

3.1 PC Client Screen

The UCS Client Console consists of the Main application menu (File, View, Tools and Help),
Message and Status bar, My Detail information, main window for Presence, Phone, Logs and
Call View, and Quick Call Control bar.

The 5 parts of the UCS Console are described as follows:

* The File, View, Tools and Help menus are discussed in Section 3.
* The Message Status bar is discussed in Section 4.
* The My Detail Information is discussed in Section 5.

* The main Window for Presence, Phone, Logs and active Call views is discussed in Section
6.

* The Quick Call Control bar is discussed in Section 7.

File  View Tools  Help Main Application menu (File, View, Tools and Help)
B0 ped 0 S0 A0 o4
| ucstestersz | 1132 L i . . .
b A e o - Message Status bar (displays new Voice Mail, IM,
=4 ‘ o Note and Missed Call)
'Y 2| (e =) | My Detail Information

= Group Not Assigned (13)

ucstesterl2 L B
- Kahn

<

Gi
EdEP>r

ucstesterld L .y
- Good day

@————— Main Window for (Presence, Phone,
Logs and Call View)

ucstester3s L1 .
- online

ucstesterl4 -8
- Cffline

M ucstesterzl e
W - Offline

ucstester34 =9
- OFfline

H urstesterd Ty

il B - jhyu test

| ~
| hi Quick Call Control Bar

* UCS Client Main Screen
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The Main Application menu at the top of the console includes menu selections for File, View,
Tools and Help. Click on File to show the following selections:

File | Wiew Tools  Help

Logout
Open Received Files

Set My Presence 4
Set My Phone Status 2

My Information
Setting

Close

* Login/Logout — initiates the login or logout process with the iPECS UCS Server and system,
see section 2.4.

* Open Received Files — opens the folder where files received from other UCS Client users
are stored.

* Set My Presence — defines your IM presence state.
* Set My Phone Status — sets the phone status.
* My Information - displays your detailed information.

* Setting — displays the Setting window, where you set up and customize the iPECS UCS
Client.

* Close — minimizes the iPECS UCS Client application to the Windows notification tray.

3.2.1 Set My Presence
Presence establishes your availability to be part of an Instant Messaging (IM) session. iPECS
UCS Server monitors and automatically updates your Presence as Online, Offline, Busy or In a
Meeting. The presence of other users is also provided in the Presence window (refer to Section
6.1).

Your status is displayed by the IM Status icon, which is located on the left above your picture.

You may change the status with the Set My Presence selection in the File menu, or by clicking
the IM Status icon.
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To change the UCS Client IM status:

1. Select Set My Presence from the File menu.

File wiew Tools  He

J_‘_ugsh:sh
I Online
m  Busy
Suway
Be Right Back
Out of Office
In a Meeting
® [ND

2. Select the IM status (presence) desired from the status window.

3.2.2 Set My Phone Status

Using Set My Phone Status, the UCS Client can be placed in a Do-Not-Disturb state or calls to
the UCS Client may be sent (forward) to another destination. When in DND, internal callers
receive a fast-busy tone and outside callers are routed based on iPECS system admin settings.

Simple Call Forward is activated from the phone allowing the user to define the type of Call
Forward (all calls, busy, and no-answer) and destination for the calls.

Remote Call Forward or Follow-me forward is activated from a different phone allowing the
user to define the type of calls to forward and the destination for the calls. For Follow-me
forward, the user must also enter the station number and the password (Authentication code)
to activate Remote Call Forward.

Call Forward ICR accesses the Individual Call Routing feature where the user can define
various Call routing scenarios as discussed in Section 10.

File | wiew Tools Help

Logout R 0 EBS0 Ef1 o

Cpen Received Files = = {

Set My Presence 3
Set My Phone Status 3 Clear |

My Information DD
Setting Call Forward »

T T TR -
Close

4

NOTE

When DND or Call Forward is activated, a confirmation window will display at next login, DND
or Call Forward can be deactivated in the confirmation window.

3.2.2.1 Clear All
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You may deactivate Call Forward or DND with the Clear selection in Set My Phone Status sub-
menu of the File menu, or by selecting the Phone status icon.

To deactivate Call Forward or DND:
1. Select Set My Phone Status from the File menu or the Phone status icon.

2. Select Clear from the status window.

(@ st

File Wiew Tools  Help

B0 ped D BAD

ucstester3z | 1132 O—— Phone Status icon ( )
4
I\

: ; Clear |
6

DMD

Call Forward(Simple)
Call Forward{Remote)
_ Call Forward({ICR)

3.2.2.2 Set Do Not Disturb (DND)

You may activate DND with the Set My Phone Status selection in the File menu, or by selecting
the Phone Status icon.

To activate DND:

1. Select Set My Phone Status from the File menu or the Phone status icon.
2. Select DND from the status window.

(@ wsan

File wiew Tools  Help

Ed0 ped 0 EBSAD

ucstester3z | 1132
S 4 Clear
?«» L

a - Call Forward(Simple)
Call Forward(Remote)
_ Call Farward{ICR)

3.2.2.3 Set Simple Call Forwarding

You may select to re-route incoming calls to other stations, station groups, the system Voice

Mail, or to an outside number. You may forward calls based on your IM presence state and
define the forwarding type (condition) for calls.

To activate Call Forward:

1. Select Set My Phone Status from the File menu or the Phone status icon.

2. Select Call Forward (Simple), the Simple Call Forwarding window displays.
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3.2.2.4

(71 Simple Call Forwarding

) Member List Select Members

= M Presence
ondition

= Forwerdng Type

O Uncandtional

) Mo Arewvote

") Byl Aehsvre

In this window click on and enter the Destination information (as needed).

. Select the IM status required to forward calls or select All IM Status to forward calls regardless

of the IM Presence state.

. Select the Forwarding Type.

. Click OK to activate Call Forward.

Set Remote Call Forwarding
To activate Call Forward, Remote (Follow-me):

. Select Set My Phone Status from the File menu or select the Phone status icon.

. Select Call Forward (Remote), the Remote Call Forwarding window displays.

[Vl Bemote Call Forwarding @

= Remote station 4200
» passward AR

= Destination & station 4103

(O HuntGraup

= Forwarding Type (O Clear

(1Mo Answer

(0 BusyiNo Answer

(114 Cancel

Input your Remote Station number.
Input your Station Authorization Code (Password)

Input the Station or Station Group to receive calls.

. Select the desired Forwarding Type.

. Click OK to activate Call Forward.
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3.2.2.5 Set ICR (Individual Call Routing)

3.2.3

Setting Call Forward ICR (Individual Call Routing) is discussed in Section 10.

Setting

The Setting menu provides a number of pages to configure the UCS Server connection, UCS
Client appearance, sound and other characteristics discussed in this section. When Setting is

selected in the File menu, the first Setting page, Server Connection, will display.

File | Wiew  Tools

Login

Open Received Files

Setting

Close

The Setting window is divided into two screens, on the left is the Setting menu navigation pane
and on the right is the data entry pane. Selecting a category in the navigation pane displays the

associated data pane.

(U] Setting
W Server Connection ==
General Profile Name i |E‘ |§| ‘il
Basic Action
Display UCS Server Connection
Sound
150.150.131.213
Eutlock Integration [Juse Detected Server IP
Cal = IP Address (xxe. oo xx)
Dialing Rules
all Popup = Login Timeout 3000~9999(msec)
Ring Sound
Audio = Server Relay Mode (8 Auto (Enable () Disable
WYoice Codec
TP Bridge Call Server Connection
Recarding
Click to Cal = Call Server IP Address (oo xen xx, 0] I:I
Functi
uncF:It;ns = Connection Mode () Auto CLocal O Remate
Sharing PBX Licernse (O Standard (&) Premium
Video
™ Call Cantral Made (@ with Yoice O no voice
LDap
Video Presentation Mode Tel Mo Password I:l
Advanced | | Metwork Diagnastics ‘
l DK ] { Cancel ] l Apply ]

The following sections cover each data item in each category available from the navigation

pane.
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3.2.3.1 Server Connection

Normally, once the Server Connection items are entered during the initial installation further
changes will not be required (refer to Section 2.4). In cases where the PC has multiple
Network Interface Cards (NICs) or a Virtual Private Network (VPN), the proper Network adapter
must be identified. The Network adapter is selected under the Advanced button of the Server
Connection Setting window.’

To modify any of the Server Connection settings:

Select Setting from the File menu, the Server Connection window displays.

V) Setting El
Profile Name | 150.150.131.213 - |B]|B][x]
Basic Action
Display ucs Server Connection
Sound
Cutiook Integration [ Use Detactad Server IP 150.150.131.213
call = IP Address (o000, 000 150.150.131.215
Dialing Rules
Call Papup = Login Timeout 3000~9999(msec) 5000
Ring Sound
Audio = Server Relay Mode  (3) Auto () Enatle (O Disable
Voice Codec
TP Bridge Call Server Connection
Recording 150,150,131 213
Click to =l = Call Server IP Address (oo, o, o0d) .150.131,
Functi
UHCF:E:S = Connection Mode @ At (O Lacal () Remate
Sharing UICS License () Standard (&) Premiurm
Video
™ Call Control Mode (3 with Voice )Mo Yoice
LDaP
Video Presentation Mode Tel Mo, Password
Advanced ‘ | Metwaork Diagnostics ‘
l oK J l Cancel ] I Apply

Change the desired item(s).

Click Apply or OK to exit.

In the Server Connection screen, the selections are:

UCS Server Connection

* Use detected server IP —when the UCS Client application is launched, it attempts to locate
a local iPECS UC server. If found and this item is checked, the UCS Client will use the
located UC server for services.

* |P Address — input box for the IP Address or domain name of the UC server.
* Server Relay Mode — relay mode between the UCS Clients; Auto is recommended.
— Auto — Session connection is determined by the UCS Client automatically.

— Enable — Implements the server relay function so that the UCS Client can establish a
connection to others when separated by a firewall. In this case, the UC server acts as a
relay to distribute session (IM, File Send and Sharing) packets to other users. This
mode connects UCS Clients separated by a firewall.

— Disable — Implements a peer-to-peer connection for the session.

18
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Call Server Connection
* PBXIP Address — IP address of the IPECS host system serving the iPECS UCS Client.

* Connection Mode — connection mode between the UCS Client and the iPECS; Auto
Connection mode is recommended.

— Auto — selects either Local or Remote automatically.

— Local - connection is employed when the iPECS system and UCS Client are on the
same LAN.

— Remote — supports packet relay.
* UCS License — selects either Standard or Premium.

— Standard — UC server is embedded in PBX and function is restricted compared to
Premium.

— Premium — UCS Server is installed in independent PC and enhanced functions are
available.

* Call Control Mode — selects either With Voice or No Voice.

— With Voice — UCS Client provides an audio path for voice, so you can call without a
desk phone.

— No Voice — UCS Client is employed for call control only; the client does not provide an
audio path for voice. A desk phone is required. For No Voice, you must set the [Tel No.]
and [Password] fields.

Advanced Settings

U] Advanced Setting &

Your CurrentIP : 0.0.0.0

Network Adapter Selection

'

l 0K l l Cancel ]

* Connect with Selected Adapter — enables selection of a specific network adapter.
* Your Current IP — displays current IP Address.

* Network Adapter Selection — displays network adapter list; select the desired network
adapter.
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Network Diaghostics

() Network Diagnostics

Test Start | | Caneel

[¥ Ping Test [¥ UDP Message Test

Gateway ..... [
TCP Table Info ..... ok

[General Ping Test ]

1044 bytes from 192,168,10.10: icup_seq=3489 41128 tine=11 ns
1044 bytes from 192,168.10.10: jcwp_seq=3430 141123 tine=3 s
1044 bytes from 192.168,10.10: icup_seq=3491 ££1=128 tine=6 ns
1044 bytes from 192,168.10.10¢ icwp_seq=3432 141123 tine=3 ms
1044 bytes from 192,168.10.10: icwp_seq=3433 141123 tine=3 s

[ DP Messaze Test ]

Test Message Send : 0001 : 0422873
[0001] : Delay time = 62 msec
Test Messaze Send @ 0002 : 0423379
[0002] : Delay time = 31 msec
Test Messaze Send @ 0003 @ 0424379
[0003] : Delav tine = £2 msec
Test Message Send : 0004 : 0425873
[0004] : Delav tine = 15 msec
Test Messaze Send : 0005 : 0426873
[0005] : Delay time = 31 msec

Test End

[ Send To Email H Save H Close l

* Test Start — start network diagnostics

* Cancel — cancel network diagnostics

* Ping Test — ping test option between a UCS Client and UC server.

* UDP Message Test — application message test option between a UCS Client and UC server.
* Send To Email — sends the test results as an E-mail attachment.

* Save — saves the test result to a file.

* Close — exit network diagnostics.

Defined Profiles can be selected from the drop-down list or added/edited/deleted with the
Profile Name Tool buttons:

U] Setting §|
W Server Connection = (==

General Profile Name [: 2] |§’l|
Basic Action
Cisplay UCS Server Connection
Sound

150,150,131.213

Cutlook Integration [Juse Detected Server T°

Call = IP Address (o oo, s, ) 50,150.13
Dialing Rules
Call Popup = Lagin Timeout 30009999 msec) S000
Ring Sound
Audio = Server Relay Mode (&) Auto () Enable () Disable
Woice Codec
1P Bridae Call Server Connection
Recording
Click to Cal = Call Server IP Address Cooxsoexxsoaoa |192.168.122.153

Fi ki

un[F:;:'s = Connection Made () Auto O Local () Remate
Sharing PEX License () Standard (& Premium
Video
™ Call Control Mode (2 with Voice Cino vaice
LDAP
Yideo Presentation Mode Tel hio. Password l:l
Advanced | | Metwork Diagnostics |
oK ] l Cancel ] l Apply
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3.2.3.2

Select Profile Name.

Click on the Add or Edit tool button.

Click to select/deselect the Use Detected Server IP option.
Enter the IP address, Login Timeout.

Select the Server Relay Mode and Connection Mode.

Click on OK.

General
The General category consists of several sub-categories for the Basic Action, Display and
Sound pages. Items on each page are discussed below. Note that the Theme and Presence
color can be changed only if the client is not logged-in

To modify any of the General category settings:

Select Setting from the File menu, the Server Connection window displays.

Select the desired sub-category under the General heading.

U] Setting §|
Server Connection
General Set the Action Far the double click Call b
[[] it Start On Startup Window

sound [[]Login Matification

cal ©utlook Integration Show DND ar Call Forward confirm window an login,

A

Dialing Rules [C]Enable Auto away 10 minute
Call Popup " . . . . "
Ring Sound Do not display expired appointments in Today's Schedule Yiewer
Audio Show confirm window when no speaker or microphone
Yoice Codec
[P Bridge Presence Update Based on UCS Schedule
Recarding
Click ta Call My Presence for an Appointment D Mat Change

Functions My Presence After Expired Do Mot Change L
File:
sharing Presence Update Based on Qutlook Calendar
Yideo
™ Busy Status Appaintment Do Mot Change e
LDAP Qut of Office Status Appaintment Do Mok Change e
Wideo Presentation Mode

0K J l Cancel ] l Apply

3. Change the desired item(s).

4. Click on the Apply or OK to exit settings.

iPECS UCS Client for PC User Guide - Issue 4.1
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3.23.2.1

Basic Action page
The Basic Action page includes the following items:

Set the action for double-clicking — when double clicking on a user record in the Presence
window, UCS Client will take the action selected from the drop-down list (Call, IM, Detalil
Information and No Action).

Auto-Start on Startup Window — when enabled, UCS Client launches when Windows
starts.

Login Notification — if enabled, at login the login naotification message is displayed.

Show DND or Call forward Confirm window on login — if enabled, the DND or Call
Forward confirm window is displayed at login.

Enable Auto away — if enabled, when there is no activity on your computer for the Auto
away time (minutes) you set, the IM status is set to Away.

Do not display expired appointments in Today’s Schedule Viewer — if enabled, once an
appointment expires, the appointment is removed from the My Detailed Information window.

Show confirm window when no speaker or microphone — if enabled, a warning message
is shown when attempting to open UCS Client on a PC without a speaker or microphone. If
disabled, UCS Client will open even if no audio devices are connected to the PC. However,
calls cannot be placed from the UCS Client since no audio devices are available.

My presence for an Appointment —the presence status changes to the entered status
automatically at the start of a UCS schedule.

My presence After Expired — the presence status changes to the entered status
automatically at the completion of a UCS schedule.

Busy Status Appointment — the presence of the UCS Client changes to the entered status
at the start of an imported Outlook schedule where the presence has been set to “Busy”.

Out of Office Status Appointment —the presence of the UCS Client changes to the
entered status at the start an imported Outlook schedule where the presence has been set
to “Out of Office”.

22
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3.2.3.2.2 Display

V] Setting

&

= Server Connection
= Genersl
= Basic Action

Language

English vy

= Sound

= Outlook Inkegration
= Call

= Digling Rules

= Call Popup

= Ring Sound

= Audio

= Voice Codec

= [P Bridge

= Recording

= Click to Call
= Functions

= File

= Sharing

= Yideo

=M

= LDAP

= Yideo Presentation Mode

[ DK ]l Cancel ]l Apply ]

* Language — selects the display language (English or Local).

3.2.3.2.3 Sound

U] Setting [Z|

= Server Connection
= Genersl
= Basic Action
= Display
= Dutlook Integration [ News IM Motification

= Call
= Dialing Rules [[] Admin message Motification

[]Program Start Motification

[]Program End Mokification

= Call Popup
= Ring Jound [ Logon Matification
= Audio
= Yoice Codec
= IP Bridge Mute &l Sounds ]
= Recording
= Click ta Call

™ Functions
= File
= Sharing
= Video
=M
= LDAP
= Yideo Presentation Mode

AR EAREINEIRED

l DK ]l Cancel ]l Apply ]

* Program Start Notification — when enabled, play the Program Start alert.

* Program End Notification —when enabled, play the Program End alert.

New IM Notification —when a new IM message is received and notification is enabled, the

new IM message warning tone is received. Note the warning tone is not received while the

IM window is active.

* Administrative message Notification — when enabled and a message is received from
UCS administrator, play the notify message Sound.

* Logon Notification —when enabled and the user logs in, play the logon notification sound.

Mute All Sounds — click to deactivate all sounds.
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3.2.3.2.4 Outlook Integration

0] Setting g|

Server Connection
General || Disable Outlock Security Warning
Basic Action
Display Outlook Calendar Synchronization
Sound [7] Enable Outlook Schedule {Auto Synchronization from Outlook to UCS)
Outlook Integration
cal set Default Folder
Dialing Rules
Call Popup
Ring Sound Open Synchronized Appointments to All Shared Users
Audio
Yoice Codec
IP Bridge
Recording Outlook Contacts Synchronization
Click.ta Call [7] Enable Outlook Contacts (Auto Synchronization from Outlook to UCS)
Functions
File: A= Set Default Folder
Sharing
Widen
I
LDAap Show Synchronization Result |
Wideo Presentation Mode

[ oK J[ Cancel H Apply

* Disable Outlook Security Warning — when enabled if the UCS Client accesses Outlook
information such as the address book, mail or appointments, the Outlook security window is
bypassed and the information is displayed.

* Enable Outlook Schedule (Auto Synchronization from Outlook to UCS) — enables
synchronization between iPECS UCS user’s Private schedules and Outlook. At login, the
UCS Client may present a confirmation window so that you may confirm synchronization
with the Outlook schedules. If confirmed, UCS Client will download the schedules from
Outlook. After login, if schedules are changed in UCS, the Outlook schedules are also
modified.

NOTE

Only schedules for the current and next month are synchronized. Schedules from the
previous months, or beyond the next month are not synchronized.

* Set Default Folder —when checked, the UCS Client calendar is synchronized to the default
Outlook calendar folder.

* Show Outlook Synchronization Confirm window — when Outlook calendar
synchronization is enabled, a confirmation window can be presented allowing you to allow or
disallow synchronization.

* Open Synchronized Appointments to All Shared users - when Outlook appointments are
synchronized, the appointments are shared based on this selection. You may select ‘Do
Not Open to All Shared users’, Open to All Shared Users or ‘Follow the Property of Outlook’.
Selecting ‘Follow the Property of Outlook’ option, shares appointments based on sharing
options in the Outlook appointment.

* Enable Outlook Contacts (Auto Synchronization from Outlook to UCS) — when enabled,
the UCS Client Private Directory and Outlook contacts synchronize during login. At login,
the UCS Client may present a confirmation window so that you may confirm synchronization
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with the Outlook contacts. If confirmed, UCS Client will download the contacts from

Outlook. After login, if the contacts in UCS are modified, the Outlook contacts are also
modified.

Set Default Folder — when checked, the UCS Client Private directory is synchronized to the
default Outlook Contacts folder.

Show Outlook Synchronization Confirm window —when Outlook contact synchronization
is enabled, a confirmation window can be presented allowing you to confirm synchronization.

Delete All Imported Private Users Before Synchronization — If enabled, at login all
previously imported contacts will be deleted before synchronization.

Show Synchronization Result - when enabled, you will be presented a window displaying
the results from the synchronization.

3.2.3.3 Call

The Call category includes settings for Dialing rules, call pop-up boxes and several audio
settings as discussed below.

To modify any of the Call category settings:

1. Select Setting from the File menu, the Server Connection window displays.

V] Setting [E‘
[m Server Connection
Access Code

|® General

Basic Ackion co 9 PEX

Display 0 ! i

Sound | Courntry 182

Outlook Integration L z E
= Call Area | | Inkernational |

= Dialing Rules

File:

Call Papup [ Add a zero before the area code when dialing within the country
E:;:Dund Advanced
Yoice Codec
IF Bridge Enbloc Dialing
Recording
Click.to Call @on
|® Functions (O OFF

Sharing

Yiden

ma

LDAP

Yiden Presentation Mode

| 1] 4 H Cancel || Apply

2. Select the desired sub-category under the Call heading.
3. Change the desired item(s).

4. Click Apply or OK to exit settings.

3.2.3.3.1 Dialing Rules

When placing an outside call from any of the UCS Client windows (e.g. Presence, Logs, etc.),
certain digits may need to be included or removed to assure proper dialing through the iPECS
system. When a number is selected from a window, the UCS Client will compare the number
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to the dialing rules. The dialing rules country and area codes are compared to the number,
and if matched, are deleted from the number. If not matched, the appropriate Area (LD) or
International codes will be inserted, preceded by the PBX, CO or IP line access codes.

* Access Codes — entered in the Dialing Rules window, along with local codes for
comparison.

* Add a zero before the area code when dialing within the country — if enabled, includes
the area code with the leading zero when dialing within the country.

* Enblock Dialing — when enabled, digits dialed for a call are sent at one time rather than
sending each digit as dialed. When IP Bridge mode is enabled, it is recommended that
Enblock Dialing be enabled. Note that for proper operation, Phonebook entries should
follow normal conventions (ex., +country code (area code) number [ex., +41 (041) 4904636])

Advanced Dialing Rules

(U] Advanced Dialing Bules

= Filtering Code
1024

= Insert Mumbers if =" iz found

1234

= Pause Time (mz) if P or ', is found

3000

[(ial Area Access Code In Same Area

|. Advanced |

[ 0K H Cancel ]

* Filtering Code — code is used for special cases to search contact directories. To add this
code, please ask your system administrator.

* Insert Numbers if ‘=" is found — replaces ‘=" with the assigned number. This is useful to
dial a long number.

* Pause Time (ms) if ‘P’ or’," is found — if a number includes the pause code, ‘P’ or ‘,’,
dialing pauses for the timer value in milli-seconds set here.

* |If the area code is required for local dialing, the Dial Area Access Code In Same Area
option must be checked.
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Special Dialing Rules

Normally, dialed numbers that do not have an area or country code defined in the dialing rules
are routed as an internal call. Using the Special Dialing Rules, dialed numbers matching the
defined rules are routed as external CO calls.

[v] Special Dialing RBules

Enable CO Call for non-standard phone number

Enable CO Call with following prefix digits
El add X Delete
Prefix Digit{s)

1 010
2 |339

[#]Enable CO call with following number length

le |

ok || cancel

* Prefix Digits — If the first digits in a dialed number match the assigned ‘Prefix Digit(s), the
call is routed as an external CO call and the CO access code is added automatically.

* Length — If the length of the dialed number is longer than the defined length, the call is
routed as an external CO call and the CO access code is added automatically.

3.2.3.3.2 Call Popup

X

(1) Setting
Server Connectian Call Pop-up Outlook Pop-up
General
B‘?Sic Action Use Pap-up [Juse Pop-up
Display
Sound [Jinternal Call
Outlook Integration
Call A=/ Set Default Folder
Dialing Rules
Call Popup q
Call Pop-up Trigger
Ring Sound A LR
Audio -
] Ringin
Yoice Codec and
IP Bridge [(IRing back
Recarding
Click ta Call ) B
X Call Window Dption
Functions
File Show Call Tab window when call is connected
Shdarlng [[] &nsewer/Drop & Call with Enter Key in Call Pop-up Window
vi
“lq =0 [[]Cisplay Registered Call Memo on Call Papup
LDAP [ 5haw Call Memo Window Automatically
Video Presentation Mode [ 5how Flex Button Window when Phone Tab is open
l 114 ] l Cancel ] l Apply ]

* Call Pop-up — check to enable the UCS version Call Popup.

@ mbound )
- ucstester13
g, It
¢ -
TRANS Qo Voicemail
N Ring Mute

* OQutlook Pop-up —when Call pop-ups are enabled, the client will display either the UCS
popup shown above or the Outlook popup. Check to enable the Outlook Popup in place of
the UCS popup. If you check Internal Call, the Outlook popup will also display for internal

calls. The default folder for the Outlook contacts must be defined.
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= UCS User 2 - Contact
Pfle Edt View Insert Formab  Took  Actions  Help

: o save and close gy 4 Wl | ¥ 52y G -

v\.sha

EBX

General | Detalls | Activities | Certfficates | Al Fields

Department: BCS Application Team
Job title:
File as: 1ICS User 2

Phone numbers
Business. 4101

Business Fax...

O LBEW

Mobie. .
Addresses
Business. ..
2ip code(2):
State(D):

Ciey(Q):
Street(B):

CountryjRegion(f): Korea

[¥] This is the mailing address

Last(G): UCS User 2 First():

-

Company:

E-mail.. [+ ucsusereqin-nortel.com
g Display as: UCS User 2 [ucsuser2@lg-niortel. com)
- wreb page address: ||

IM address;,

Private []

* Call Popup Trigger — defines the event that will cause display of the selected popup, both
incoming calls and outgoing calls may trigger the call popup.

* Call Window Option — the Call tab in the main window can be displayed when a call is
connected or when a call is answered or dropped with Enter key in the popup window.
When you set ‘Display Registered Call Memo on Call Pop-up’, incoming and outgoing calls
are displayed in the Call Memo window. Also, if you want to activate the Call Memo window
automatically when a call is received, select the ‘Show Call Memo Window Automatically’

option.

For more information about the Call Memo window, refer to Section 8.8. Select

the ‘Show Flex Button Window when Phone Tab is open’ to see the Flex Button window
automatically when the Phone tab is selected.

NOTE

For proper operation with ‘Answer/Drop a Call with Enter Key in Call Pop-up Window’ enabled,

the UCS call popup must be the active window.

If the Outlook call popup is selected or you

select a different window while the UCS call popup is displayed the call cannot be answered or

dropped with the Enter key.
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3.2.3.3.3

Ring Sound

IPECS UCS Client can provide one of four (4) ring signals with separate assignments for
internal and external calls. Each of the four (4) ring signals is contained in an *.wav file. You
may select one of the four *.wav files (ringl.wav, ring2.wav, ring3.wav and ring4.wav) or
replace any of these files with a desired *.wav (PCM) or *.mp3 file.

U] Setting &|
Server Conneckion - -
Station Ring
General o
Basic Action |C:WProgram FilesWUCS ClientSound Wring1 . way | | P_'|| | » |
Display T
Sound .
Cutlook Integration €O Ring -
Call |C:WPrngram FilesWUICS Client W Sound Wring2 way | | Dl | » |
Dialing Rules T

Ring Style
Woice Codec O Flay ring at the minimum volume
IP Eridge
Recarding () Play ring gradually
Click to Call
Functions () Play ring at the specified volume
File 2
-
Sharing
Wideo
I
LDAP

Yiden Presentation Mode

[ DK ]l Cancel ]l Apply ]

* Station Ring — selects the ring signal for internal calls. You can check the ring signal in
advance.

* CO Ring - selects the ring signal for external calls. You can check the ring signal in
advance.

* Ring Style — one of three ring volume treatments can be selected, minimum, gradually
increase, or at the specified volume.

3.2.3.3.4 Audio

The UCS Client will deliver tone signals (ring) as well as voice signals to the defined device.
Select a Speaker to receive Ring/DTMF and select a Speaker and a Microphone for voice
communication. The Speaker is defined separately for voice and ring signals.

(U] Setting §|

Server Conneckion
General
Basic Action
Display
Sound Sound Blaster 16 -

Device for Ring/ Tone

Speaker : Sound Blaster 16

Outlook Ink ti
call ook Integration [[]Enable PC Speaker Beep Sound
Dialing Rules

Call Popup Device for Yoice
Ring Sound

Speaker : Sound Blaster 16
Woice Codec
IP Bridge
Recarding
Click to Call Microphone : Sound Blaster 16

Functions
File
Sharing
Wideo . .
™M Audio Wizard | | Headset Integration |
LDAP
video Presentation Mode

Sound Blaster 16 -

Sound Blaster 16 e

oK H Cancel H Apply ]
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Audio Wizard

Device for Ring/Tone

Select device for ringing and tone

Device for Communication
Select device For audio input

Realtek ACST Audio £
Select device For audio autput

PC Camera -

[ prev H Next H Close ]

* Device for Ring/Tone — defines the devices for ring and tones.
sound for incoming calls if this option is enabled.

PC Speaker Beep tone will

* Device for Voice — defines the devices, speaker and microphone, for voice communication.

* Audio Tuning Wizard — assists in adjusting the volumes for the Speaker/Microphone.

There are three ring styles for an incoming call ring signal, minimum, gradually increase, or at
the specified volume. From the wizard, the style selected is played allowing you to determine if
it is acceptable. If you check Enable PC Speaker Beep, the beep is played.

) Audio Wizard

Ring/Tone Device Test
Iows you can listen the ring sound in the speaker

) Play ring at the minimum valume

@

pecified volume

[]Enable PC Spesk Beep Sound

Prev H MNext H Clase ]

On the Communication Test page of the wizard, you can check the volume level of the speaker
and microphone. Any sound picked up by the microphone is displayed under the microphone
section of this page. The volume level varies if the PC sound devices are properly set. If you set
‘Let UCS adjust microphone volume’, Automatic Gain Control (AGC) is used to adjust the

microphone volume.

2] Audio Wizard 3

Communication Test

Audio Input @ Realtek ACS7 Audio
Audio Output :pC Camera

Spesk on the mic, Then, you wil listen your voice on the
speaker

Adiust speaker's volume

Adjust microphone’s volume
[FlLet UCS adjust microphone's volume

| prev H Nent H Close ]
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These options can improve voice quality in noisy environments. By increasing the noise
suppression, noise patterns are removed during conversation. For example, if you say ‘Ah~’,
continuously, the pattern will be removed from the conversation.

) Audio Wizard X

Options

Ena
Enable Noise Suppression

(® Mormal Made
© Medium Mode
Q) Strang Mode
O Wery Strang Mode:

| prev [ mewt || Finish |

* Headset Integration — when headset integration is enabled, operation of the headset hook-
switch function for answering or dropping a call is recognized when using one of several
headsets. The supported headsets with the hook-switch function include:

(3 ()

— Audio 910 Headset

— CS 50/60 USB Headset, press volume up or down button for more than 3 seconds to dial
the assigned numbers.

— GNB8120 Headset
— Common Devices — Plantronics

— Common Devices — GN Netcom (Jabra)

NOTE

The operation of remote hook-switch varies between headset manufacturers and models. To
use one of the listed headsets with UCS Client, refer to the manual packaged with the headset.

To use the hook-switch function when a “Common Device” is selected, special Windows drivers
are required. These drivers are available on the UCS Server and may be downloaded using the
link at the bottom of the Headset Integration page or from the Client download page accessed
from the UCS Server login page. In addition, for the Plantronics Common Devices,

Microsoft .Net Framework 3.5 or later is required. The UCS Client will check for this software
and, if not installed, you will be prompted to download and install this software prior to
installation of the drivers.
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3.2.3.3.5 Voice Codec

3.2.3.3.6

(V) Setting

X

= Server Connection
= General
= Basic Action
= Display
= Sound
= Cugtlook Inkegration
m Call
= Dialing Rules
= Call Popup
= Ring Sound
= Audio
Yoice Codec
= IP Bridge
= Recording
= Click ta Call
= Functions
= File
= Sharing
= Video
= IM
= LDAP
= Wideo Presentation Mode

Select Codec
() System Codec

(@]
[@]=Rrs

l

1] 4

H Cancel H Apply ]

IP Bridge

Select Codec — defines the preferred codec (System codec, G.711 or G.729).

* Enable IP Bridge — the UCS Client can be linked with an iPECS desktop IP Phone so that a
call can be placed from the client and the voice path established through the IP Phone by
lifting the handset or pressing the Speaker button.

= Server Connection
" General
= Basic Action
= Display
= Sound
= Outlook Integration
o Call
= Dialing Rules
= Call Popup
= Ring Sound
= Audio
= Voice Codec
= Recording
= Click ta Call
= Functions
= File
= Sharing
= Video
= I
= LD@P

= Video Presentation Mode

[C]Enable IF Bridge

0K

H Cancel H Apply
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3.2.3.3.7 Recording

(V) Setting

X

= Server Connection
= General
= Basic Action
= Display
= Sound
= Cugtlook Inkegration
m Call
= Dialing Rules
= Call Popup
= Ring Sound
= Audio
= Yoice Codec
= IP Bridge
Recording
= Click ta Call
= Functions
= File
= Sharing
= Video
= IM
= LDAP
= Wideo Presentation Mode

Recording Folder

|C:WProgram FilesMJCS Client'Wrecording ‘ @]

[ 0K H Cancel H Apply ]

* Recording Folder — defines the folder where recorded call files are stored.

3.2.3.3.8 Click to Call

U] Setting

X]

m Server Conneckion
= General

= Basic Action [[]Enable Capturing Mumbers by Mouse Dragging
= Display

= Sound

= Outlook Integration
= Call

= Dialing Rules

= Call Popup

= Ring Sound

= pudio

= Voice Codec

= IP Bridge

= Recording

Call

Capturing Numbers to Click to Call

= Functions
= File
= Sharing
= Video
= IM

= LDAP
= Video Presentation Mode

[ 1] 4 H Cancel H Apply ]

* Enable Capturing Numbers by Mouse Dragging - when you drag your mouse over a
phone number in a browser window, the number is captured into the Quick Call Control Bar
and the Call Assistance. However, capturing over several windows is not allowed. For
example, capturing will not work if you click the left mouse button to start in one program
window and release mouse button in another program window.
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= =

6 = & httpy//www.Igericsson.com/index.html

@ Igericsson.com

SOLUTIONS PRODUCTS

Partner Login

SUPPORT PARTNERS

ABOUT

Company Information
Vision

Sustainability Management

B Q2220052129 [
R&D Overview -
Fress © Cheongju Operations R&D (Anyang)
Careers Dasjean Office =
. Hogye 1-dong, Anygg Si Dongan- EQ Tel 82-31-450-4098~9

Locations & D 1749 K Fax 82-31-450-7047

gu, Gyeonggi-Do, @317 orea @ Fax82-31-450-7047

Global Office Daegu Office = gu, Gyeongg

Korean Office

Newsletter

Locations
Korean Office

O Headquarter
O R&D Center

Busan Office =
= Guang-ju Office

HOME = ABOUT = LOCATIONS = KOREAN OFFICE (=

Headquater (Kangnam)

GS tower 679 Yeoksam-dong,

Gangnam-gu, Seoul, Korea 135-925%

SCO (Cheongjul§

Hyangjeong-dgg, Cheongju Si B} Tel 82-43-279-1114

Heungdeokgl, Chungcheongbuk- B Fax 82-43-279-0971

g5, Korea

I di—

.32-2-3777-1 114 beal M=ap)]

NOTE

Characters captured can be numeric digits, ‘+’ (plus sign), - (dash) and ‘,’ (comma).

3.2.3.4 Functions

Under Functions, settings are available for Sharing, video, IM logging and database
characteristics as discussed in detail below.

To modify any of the Function category settings:
1. Select Setting from the File menu, the Server Connection window displays.

2. Select the desired sub-category under the Function heading.

) Setting

X

= Server Connection
™ General
= Basic Action
= Display
= Sound
= Cutlook Integration
= Call
= Dialing Rules
= Call Popup
= Ring Sound
= Audio
= Woice Codec
= IP Bridge
= Recording
= Click to Call
= Functions
= Sharing
= Video
= 1M
= LDAP

= ¥ideo Presentation Mode

File Receiving Folder

|C:WProgram Files'WUCS Client Wreceivedfile

DK ]l Cancel ]l Apply

3. Change the desired item(s).

4. Click Apply or OK to exit settings.
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3.2.3.4.1 File

* File Receiving Folder — defines the folder where files received from other UCS Clients are
stored

3.2.3.4.2 Sharing

Application Sharing

U] Setting §|
Server Cannection o )
Ganeral Application Sharing
Basic Action () Application from Share List
Display ) ) )
Saund (3) Any windows in the Shared window
Outlook Inkegration Capture Resolution
Call
Dialing Rules 50 Y
Call Popup
Ring Sound
Audio Desktop Sharing
Yoice Codec Capture Resolution
IP Bridge - = o,
Recording
Click to Call
Functions
File
Yideo
ma
LDAP
Yideo Presentation Mode

[ 0K Jl Cancel ]l Apply ]

* Application from Share List — only shares files from the Shared List during a sharing
session (refer to Section 11.3.3).

* Any windows in the Shared Window — shares all windows that are moved or displayed in
the Sharing window including files in the Shared List, refer to Section 11.3.3. Certain types
of files such as Internet browsers may not be recognized by the sharing module as
applicable to sharing. In this case, selecting Any Windows in the Shared Window allows a
window to be drag to the Sharing window for display to participants.

* Capture Resolution — sets the capture resolution (10, 20, 50, 80, and 100%). Higher
resolution improves quality but can significantly increase LAN traffic.

Desktop Sharing
* Capture Resolution — sets the capture resolution (10, 20, 50, 80, and 100%). Higher
resolution improves quality but can significantly increase LAN traffic.
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3.2.3.4.3 Video

Ul Setting
= Server Connection _
Yideo Frame rate

= General
= Basic Action 2
= Display " T "
= Sound Slaw Tormal Fast
= Outlook Integration

m Call Slow
=DialigRiks Modern or ISDMIE4Kbps) Metwork Environment
= Call Popup
= Ring Sound Mormal
= Audio .
e — D5l Cable or TI(1SMbps) Metwaork Environment
= IP Bridge Fast
= Recording
= Click to Call LAN(10Mbps or higher) Metwark Environment

I Funct!ons Device for ¥ideo
= File
= Sharing

e
=M Answer for ¥ideo Request
= LDAP
= Video Presentation Mode [] allows Wideo Regest Automatically

l 0K J | Cancel | l Apply ]

* Video Frame rate — sets the video frame rate (Slow, Normal, and Fast). Because added
processing time is required, faster frame rates may affect quality.

* Device for Video — sets the video input device. If there are more than two devices, the
user may select a device from the list.

* Allow Video Request Automatically — when enabled, automatically answer all incoming

video requests.

3.2344 M

V) Setting

X

= Server Connection
= General 1M Log
= Basic Action [JEnable IM Log
= Display
= Sound
= Cutlook Inkegration
m Call [JPapup On Mew IM Message
= Dialing Rules
= Call Papup IM Window Popup Position on Multi-Monitor

= Ring Sound
= fAudio () Monitor where ucs main windaw is showed

M Window Popup

= Voice Codec

= IP Bridge

= Recording () wehole of Central Deskiop

= Click to Call
= Functions

() Primary manitar

= File

= Sharing

= Video

= LD@P

= Video Presentation Mode

o) Coanee ) (Coen

* Enable IM Log — enables the IM Log, all IM sessions are stored until erased, refer to
Section 6.3.

* Popup On New IM Message — enables the minimized or hidden IM window to popup when
a new IM message is received.

* IM Window Popup Position on Multi-Monitor — sets the popup position of the IM window
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in Multi-monitor environments.

— Monitor where UCS main window is shown — IM Window will be displayed at the
monitor where the UCS Client main window is shown.

— Primary monitor — IM window will be displayed at the primary monitor where Start Menu
and Desktop Shortcuts are displayed by Windows.

— Whole of Central Desktop — IM window will be displayed in the center of the screen.

3.2.3.45 LDAP

U] Setting

(X

Server Connection
General

Basic Action Server Name "

Display

Sound

Outlook Integration
Call Advanced

Dialing Rules

Call Popup

Ring Sound

Audio

Yoice Codec

IP Bridge

Recarding

Click to Call
Functions

File:

Sharing

Viden

I

LDAP

Video Presentation Mode

LDAP

[ (1] 4 H Cancel H Apply ]

* Server Name — identifies the LDAP Server. A LDAP server defines the server where UCS
Server databases reside.

— Advanced - to view the advanced LDAP Setting window.

U] LDAP Setting -

0K || Cancel J
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3.2.3.4.6 Video Presentation Mode

0] Setting

X

Server Cannection
General

Basic Action 4 " 1 "

Display

Sound

Outlook Integration
Call

Dialing Rules

Call Popup

Ring Sound

Audio

Woice Codec

IP Bridge

Recording

Click to Call
Functions

File:

Sharing

Wideno

Master Send Frame Master Receive Frame

1] 4 H Cancel H Apply ]

* Master Send Frame — maximum number of frames that can be sent by the organizer.

* Master Receive Frame — maximum number of frames that can be sent by the participants.

NOTE

The organizer PC in presentation mode should have considerable CPU power to process video
frames received from up to 32 users. Using higher frame rates requires higher CPU power to
process the video frames.
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3.3 View Menu Selection

Selecting View shows the following selections:’

(@ ucs Client —

x

File | Wigw | Tools  Help
Yiew Selected User Detal Information 44 0
Call Assistance
)

{ Restare Default Window e
ZI Quick Call Cortral Bar E a
ZI Fhone Tah L
ZI organization

bl — - e |

* View Selected User Detail Information — displays detail information window for selected
user in the Presence or Log window.

* Call Assistance — displays the Call Assistance window.

* Restore Default Window — returns UCS Client main window to the default appearance.

* Quick Call Control Bar — determines if the Quick Call Control Bar will be hidden or shown.
* Phone Tab — determines if the Phone Tab will be hidden or shown.

* Organization — determines if the Organization Tab will be hidden or shown (options set by
Server Admin.).

3.3.1 View Contact Detalil

When a contact is selected in the Presence or Log window, basic information about the

selected contact will display along with an iconic view of the communication modes available.
Icons for available communication modes are highlighted while modes not available are shaded.
Icons and the represented communication are:

[ = 2.Private Contacts (5}

@ l?e' L'{ E fﬁ E lzl h ucskesterlz

- kahn

ucstesterlz

] mz ucstesterl3 ’
3 - Good day :

« [ Start an IM session with selected user.

* [2 Send E-mail to selected user.

« ' Make acall to the desktop phone of a selected user.
o Iﬂ Make a call to the cell phone of a selected user.

. Make a call to the office phone of a selected user.

e {4 Make a call to the home phone of a selected user.

« [»] Display other menus.
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3.3.2

— Initiate File Send, Sharing, Web Push or Video call with the selected user.

File Send

=

(g, Sharing
e Web Push
@®

Video »

NOTE

To send files to a selected contact, drag and drop the appropriate file from its folder window to
the Contact Detail window.

Selected Member : UCS User 3
Do you want to send file

Call Assistance

The Call Assistance bar is always shown on top of other desktop screens to allow instant voice
communications. The bar is semi-transparent and may be dragged and dropped to an
unobtrusive location on the desktop screen.

I§ pocument1 S it Ward
i File  Edit  vie 45_0 = i T a B;
D e B vorma o HEE B

Additionally, you may activate display of the Station LCD; right click on the Call Assistant and
select ‘Display LCD’ to view the Station LCD display along with the Call Assistant.

STATIOH 4100 (T)
APR 15 08 08:02 am
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The Tools menu provides direct access to UCS Client collaboration, database and
communication services. Each of the Tools menu items can be accessed from other menus
and is discussed further in other sections of this guide as noted below.

File wiew | Tools | Help

Call » g

|+ Filz Send

g " |ig1 Sharing »
1!\5 ‘U SIS

Y, s

> Schedule

@ Wideo »

Presence
Phore

+ Grog Logs

1 1.0 M Log
Irnport Contacts 3

= 2.p
Export Contacts [

‘ : Audia Canf,
Favorite Links 2

* Call —displays the Call menu, refer to Section 8.

-~
i

* |M - displays the IM window, refer to Section 11.1.
* File Send — displays the File Send window, refer to Section 11.2.

* Sharing — contains the selections for Application Sharing, Desktop Sharing, Whiteboard,
Web Push, refer to Section 11.3 and 11.4.

* SMS - displays the SMS window, refer to section 11.6
* Schedule — displays the Schedule window, refer to Section 9.

* Video - contains selections for Video (Normal Mode), and Video (Presentation Mode), refer
to Section 11.5.

* Chat Room — displays the Chat Room window, refer to Section 11.1.2.
* IM Log —displays the IM Log window, refer to Section 6.3.

* Import Contacts — import the contents from other contact database tools, refer to Section
6.1.1.4.

* Export Contacts — export the contents of the user’s contacts to other database tools, refer
to Section 6.1.1.4.

¢ Audio Conference — establish ad hoc conferences and manage conference rooms, refer to
section 14.

* Favorite Links — displays the Program & Web Link window.
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3.5

3.6

Help Menu Selection

The Help menu displays this user guide in PDF format and the About screen, which contains
general information on the UCS Client application including the version and release date. To
display the user guide, Adobe Acrobat Reader, which is available from the Adobe web site, is
required.

(U} About (UCS Client)

(¥ uCs Client - x
WErsion i UCS Client D.0AC
File  Wiew Tools | Help
Q ” ' Release i 14JOCT)Z013
| Help |t 1 240 l
= Copyright{c) Ericsson-LG Enterprise Co., Ltd.
- DB Check e
ucske 4
Sbout (UCS Client : [ o
) . ‘ Fine ¢ ) et > ;]

Tray Menu

UCS Client places a short cut button in the right notification tray. Right clicking on the short cut
displays one of two menus depending on the login state of the UCS Client.

After Login
Open UCS Client
Make A Call Tools 2
M Presence

Logs
Set My Presence 3
Set My Phone Status »

Logout

Exit

* Open UCS Client — opens the UCS Client with the last displayed main window.
* Tools — opens the Selected Member window to either ‘Make a call’ or ‘IM’.

* Presence — opens the UCS Client with presence in the main window.

* Logs — opens the UCS Client with the Logs window.

* Set My Presence — change my presence, refer to Section 3.2.1.

* Set My Phone Status — change my phone status, refer to Section 3.2.2.

* Logout — log out of the UCS Client.

* EXxit — closes and exits the UCS Client.
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Before Login
Open UCE Client

Login

Euwit

* Open UCS Client — opens the UCS Client Login window.
* Login — opens the UCS Client Login window.

* EXit — closes and exits the UCS Client.
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Chapter 4
Message & Status Bar

The Message icons for Voice Mail, SMS, Notes and Missed calls are shown at the right above
the main window. These icons indicate the number of unheard or unread messages, and give
access to Voice Mail and message log windows.

e 0 B0 ka0 kR og O

Q ucstester3? | 1132 @
-

o ﬁ Fine day! wt
e ' b

&

&

The Message icons for Voice Mail, SMS, Notes and Missed calls are shown at the right above
the main window. These icons indicate the number of unheard or unread messages, and give
access to Voice Mail and message log windows.

Help L)

e 0 W0 B0 w1 of 2

Press the desired message icon:

* Parked Calls

* Voice mail, refer to Section 4.1.1.
* SMS, refer to Section 4.1.2.

* Notes, refer to Section 4.1.3.

* Missed Calls, refer to Section 4.1.4
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4.1.1 Voice Mail
The Voice Mail selection will access your assigned Voice mail server. If you have multiple
Voice mail servers and ‘Set the VM as Default’ is checked, the VM Selection window appears
and you may select a VM server. If “Set the VM as Default’, is not checked, the VM Selection
window is available from the Call menu under the Tools main menu. The Voice mail icon is
displayed even though no Voice mail server is assigned to your station.

(V) ¥ Selection &|

= Select the VM vou wish bo access

412 SMS

Up to ten (10) incoming SMS messages are stored in the iPECS. The SMS message log is
retrieved from iPECS by clicking the SMS icon in the UCS Client. The main window then
displays a log of the SMS messages.

l SMS ' "
Service ...  Mame Date & Time
"’ ! Phone Number: 1112

Contents: Hi. I reEeived YOUr Message.
[2013-09-13 2= 2:33:00]
M5 2013-10-16 2=
] =
&= Receive uestesterl3 6257

2 Phone Number: 1113

Contents: Are you ok. Today is Friday

[2013-09-13 @ = 2:32:00]

i

4.1.3 Notes

Notes left by other users are retrieved from the UCS Server by clicking on the Notes icon in the

UCS Client. The main window displays all received Notes.

1 Mote " ot
Service...  MName

&. 1
Contents: I received your message.

<7 Mote testerz | Z01E10-16 %
Receive TR = nomae

Contents: Hi, This_is a test message.
[2013-10-16 2 = 5:59:00]
w3 Mote L 2013-10-16 2

A
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4.1.4 Missed Calls

Missed call information is displayed by clicking the Missed Calls icon. The main window
displays detailed logs for each missed call.

b

Service... Mame Date & Time ke
~ Missed testeriy  Z013-10-16 2
1 97 cal uestester = 5i56:01
Phone Number: 1113
5 Missed testeriy  2013-10-16 z
2 97 cal ucstester =5:55:58
= Phone Number: 1113
’ > Missed N 2013-10-16 2
3 |92 cal HESLESLEr = 12:21:36

UCS Server monitors and displays your IM Presence, Phone and Video status icons, updating
the icons automatically as your status changes. These icons on displayed on the right side of
the “My Detailed Information’ area of the UCS Client window. In addition, the Presence and
Phone icons can be used to modify your status as outline in Sections 3.2.1 and 3.2.2. The
Presence and Phone status can also be changed manually under the File selection of the Main
menu. Icons and the represented status are shown below.

The Presence icons are:

. : Offline

. I : Online

e B :Busy

J : Away

. : Be Right Back
. : Out of Office

. : In a Meeting

e« E :DND

The IPECS Phone status icons are:

. > ldle

« % Busy

+ 12 DND

. Call Forward

The Webcam status icons are:

e [, Offline
o :'.ﬁ Online
. Unavailable
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Chapter 5
My Detail Information

You can view and modify the information in the ‘My Information” window including Today’s
message, ‘My picture’ and the day’s appointments. In addition, your detailed information and
password can be modified using the My Information window. Additionally, to the right

UCS Server monitors and displays your IM Presence, Phone and Video status icons, updating
the icons automatically as your status changes. These icons on displayed on the right side of
the ‘My Detailed Information’ area of the UCS Client window. In addition, the Presence and
Phone icons can be used to modify your status as outline in Sections 3.2.1 and 3.2.2. The
Presence and Phone status can also be changed manually under the File selection of the Main
menu. Icons and the represented status are shown below.

The Presence icons are;

. : Offline

. : Online

e B :Busy

. - Away

. : Be Right Back
. : Out of Office

. : In a Meeting

e E :DND

The iPECS Phone status icons are:

. > ldle

« % Busy

+ 12 DND

. Call Forward

The Webcam status icons are:

e =, Offline
* s Online
. Unavailable

iPECS UCS Client for PC User Guide - Issue 4.1 47



5.2

5.3

Setting My Picture

The ‘My Information’ window includes a user-defined picture shown to other users in the Shared
Directory and during certain IM sessions. The picture must be a .jpeg file, which will be resized
to fit in the ‘My Picture’ area.

r

1 ucstester3z | 1132 Lo Q
L'
7

i ‘ Fine day!

e
a

To change the picture:

. Select the Picture Change button (down arrow).
. From the Windows file directory, locate and select the desired file.

. Click Open to apply the selection as the My Picture file.

My Information and Password

The UCS Client sends the User ID and Password to the iPECS system and UCS Server during
login to authenticate the client. The password can be changed from the My Information
window or in the UC server Web Admin.

To change your password:

. Double click on the Picture ID to display your detailed information.
. Select Change Password, the Change Password window displays.

. Enter the current password.

" Hame |ucstestersz |
r@ ‘ = Mickname |ucstester32 |
. hange Password

* Station humber  [1132 |

= Station Mumber2

() Change Password E

|
= Current Password l:l :l
| | | I
(R | | M
]

]

|

|

|

= SH

Of
C
o
= of
O EII(I _] Cancel
of AT

® HomePhone  |+B2(031) 00000032

* Home Address |

« Email Address  |ucstester32@ucapp.com

Timezone  |(GMT+09:00) (HEMIZ A |

Cooe oo

4. Enter and confirm the desired password in the New Password and Confirm Password boxes.
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5. Select OK to save the change.

NOTE
The new password length must be equal to or greater than the minimum password length
permitted by the UCS Administrator.

To change My Information:
1. Double click on the Picture ID to display your detailed information.

2. Edit contents of any editable field. Editable fields are set by UCS Administrator.

3. Press OK to save the changes.

You can write a message to display to other UCS Clients.

To post your message:
1. Input the message.

n ucstester3z | 1132 - @
-
s A |Fine day! 'H.-'l

Pl Y . i i
L& |,_D.DD~2IZI.3IZI Marketing meeting 'H.-'l 7]

2. Press Enter button on the PC, the message is displayed in bold font.

My Information window includes a display of today’s appointments. The time and name of the
next appointment is shown in the window. If there is more than one appointment, the down
arrow button will display all appointments for the day. In addition, appointments can be viewed,
added or modified as discussed in Section 10 by clicking on the calendar to the right of the
appointment display.

0 ucstester32 | 1132 - @

=

e d Fine day! L
~ ||

=|' "ﬂ;‘ o Fn:sn ~ 21:00 Team Meeting

20:00 ~ 20:30 Marketing meeting
20:30 ~ 21:00 Team Meeting
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Chapter 6
Main Window Views

The main window has three views (Presence, Phone, Logs) selectable with the tabs at the top
of the window. The Phone tab can be hidden, see Section 3.2.3.2.

The Presence window displays the status of contacts you select from one of two directories
available with UCS. The contacts in the Shared directory, which is managed by the UCS
Administrator, are available to all users. You also have access to contacts in a second
directory called the Private User directory. A separate Private User directory, which is
managed by you and stored in the UCS Client PC, is available to you only. The Presence
window displays the status of the UCS Client, iPECS desktop phone, Webcam, Schedule and
Remote Monitoring for listed contacts using icons. For contacts not monitored by UCS, for
example external Shared or Private User contacts, no status is available to UCS and a single
icon displays their status. The tool and status icons employed in the Presence window are
shown below.

A B (3

~
+ Group Not Assigned (Z0)

+ 1.0ffice Contacts (2}

Phone &
Call Log __| E 2Private Contacts ()
G
L ucstesterla
- Kahn
ucshesterl3
- Good day
ucstesterl
Cffline

ucstesteril
- Spock, Yulcan

B cstester1a
i FFFlim

The tool icons are:
e 3. :Add Contact

[ 3
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. : Add Group

The Presence icons are;:

. : Offline

. : Online

e ®m :Busy

. : Away

. : Be Right Back
. : Out of Office

. : In a Meeting

« B :DND

The iPECS Phone status icons are:

. > ldle

« *¥ :Busy

+ 12 :DND

. : Call Forward

The Webcam status icons are:

* 7 : Offline
* @ : Online
. : Offline
. : Online

The Schedule status icon ( ) displays after the contact if the Contact has established a
‘Today’s Schedule’.

The Remote Monitoring status icon ('i') displays after the contact if the Remote Monitoring has
been allowed by the monitored user.

When a contact is selected, the contact’s information displays in the ‘Selected Contact’ window
just below the Presence window, refer to Section 6.5. In addition, icons are available in the
window for each available communication mode.

The Presence window can be used to establish communication with the listed contacts. By
right clicking the mouse on a contact, one of four collaboration and management popup menus
will display. The popup displayed is based on status and type of the contact as below.

» ONLINE POP-UP » OFFLINE POP-UP »NON-UCS POP-UP »PRIVATE USER POP-UP
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& Make Azl 4 & Make A Call » Ga Make A Call & Make A Call 3
Scheduled Dial Scheduled Dial Scheduled Dial Scheduled Dial

@ starta Video Call 4 e sms b sMsS G sms

(=Y 2 Email B2 Email k& Email

"3 File Send % Leave A Note Detail Information Detail Information

[ sharing 4 Block Move Selected Userto Maove ted Userto »

& Video ' Detail Information Delete User Delete User

b sMs Schedule Info Delete All Private Users Delete All Private Users

kg Email Move Selected Userto ¥ EditUser
Block Delete User Sort 3 View 4
Detail Information = All Private Users Sort L4
Schedule Info View R
Move Selected Userto Sort ¥

From these menus, you may select Make a Call to call the contact, initiate a collaborative
session (IM, File Send, Sharing, Web Push, etc., see section 11) with the contact, block the
selected user from receiving you presence and status information (select Block), remove the
contact from your Presence window (Delete User) or view detail contact information (Detail
Information). In addition, for offline contacts, you may Leave A Note. The following
describes menu items:

* Make a Call — places a call to the selected contact

* Scheduled Dial - registers a Schedule Dial to the selected contact
* Start a Video Call — Video with call (Normal/Presentation Mode)

* |M - starts IM session to the selected contact

* File Send — starts File Send to the selected contact

* Sharing — Initiates a sharing session with the selected contact (Application Sharing/Desktop
Sharing/Whiteboard/Web Push)

* Clicking popup item — starts one click sharing session with the selected contact and
includes selected item.

* Video - starts a Video call to the selected contact

* SMS - sends an SMS to the selected contact

* Email — sends an Email to the selected contact

* Leave a Note — leaves a note to the selected offline contact

* Block — blocks the selected user from receiving your presence

* Detail Information — opens the selected user’s detail information box

* Today’s Schedule Info — displays the selected user’s today’s schedule information

* Move Selected User to — moves the selected user to another group
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* Delete User — deletes the selected user from the Presence window
* Delete All Private Users — deletes all private users from the Presence window

In addition to selecting a single contact, you can select multiple contacts or grouped contacts
for activation of a function from the menu. To select multiple contacts:

1. Select a contact.
2. Select additional users using the mouse and Ctrl or Shift key.

3. Right-click your mouse on the contact records and selects the appropriate function in the
popup menu.

2 B 2|3

® Group Mot Assigned (Z0)
& 1.0Fffice Contacts (3)

_ B 2Private Contacts (5)

ucsted Ll 1M
=% File Send
|:g, Sharing 3

CGood @ Wideo 3
e SMS

ested 52 Email

Move Selected User to 3

Delete All Selected Users

Yy ucshe: .
- Spad Delete All Private Users
Wi 3
(5 s Sort +
") R d

NOTE

If more than five (5) online users are selected, the offline popup menu is displayed in place of
the online menu. Certain functions available from the online popup are not available to more
than six (6) users. For example, the maximum number of users in a Video Conference is six,
you and 5 other users.

» MULTI SELECT » MULTI SELECT
ONLINE POP-UP OFFLINE POP-UP

&4y Start Group Call £, Start Group Call
ﬁ Start Wideo Group Call 3 4 SMS
S 2 Email
5 File Send Delete All Selected Users
[igy Sharing 3 Wiew »
®  viden v Sort »
(4 EME
2 Emall
Delete All Selected Users
Wiew 3
Sort 3

To select contacts in a group:
1. Select a group.
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2. Right-click on the contact records then select a function from the popup menu displayed.
- & B 222

Group Mot Assigned (20)

<

1.0ffice Contacts {3}

S & 2Private Contack 1)

ucstester| 4 File Send
- Kahn .
g Sharing 4

® ‘ideo 3
ucskester]

ﬂ “Gond daf B# SMS

2 Email

| 1

11

ucsteste Fiename Selected Group
- Offline

Delete &ll Users in this group

Delete All Private Users
ucstester]

- Spack, Y Wiew 3

Sort 3

'z ucstesterld
‘ 1 CFFlien v

» Group Offline Menu

{4 Start Group Call

b4 SMS

(2 Email
Renarne Selected Group
Delete All Users in this group

WView »

Sort »

The following is a brief description of menu items available.

* Start Group Call — places a call to the selected group of contacts

* Start Video Group Call — places a video call to the selected group contacts

* Delete All Selected Users — deletes the selected users from the Presence window

* Delete All Users in this group — deletes all users in the selected group from the Presence
window.

To Leave a Note to an offline contact:
1. Right-click on a contact record.
2. Select Leave a Note (only available for offline contacts).

3. Enter your note in the Leave a Note window, maximum 100 characters.

Ul Leave a Note

= Mote

Call me, please11

0K Cancel
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4. Click OK to send the Note.

You can customize the Presence window appearance with the View selection.
* All —displays all Presence contacts

* Share — displays only Shared contacts

* Online —displays only online contacts

* Blocked — displays only blocked contacts

* Private — displays only private contacts

Also, you can define the sorting order of contacts in the Presence window with the Sort
selection.

* IM - sort by IM status
* Phone - sort by Phone status

* Name — sort alphabetically by Contact name

6.1.1 Managing the Presence Window
The Presence window has a number of tools to manage contacts, groups, appearance and
order of contacts.

6.1.1.1 Adding and Deleting Contacts
Contacts in the Shared directory may be added to or deleted from the Presence window. The
Presence window also displays the Private directory and contacts may be added or deleted.
The Shared contacts directory is stored in the UC server and is managed by your iPECS
Administrator.

N BB

>

F Group Not Assigned [20)

@ 1.0ffice Contacts ()

= Z.Private Contacts (&)

g ucstesterl?
& -kahn
ucstesterls
- Good day

ucstesterl
- OFFline

You manage the Private directory, which includes the following information for each contact:

* Name and Nickname
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* Cellular Phone

¢ Office Phone, Name, Department, FAX and Office Address

* Home Telephone, Address and Email.

NOTE
When adding a Private User contact, the contact name and Office Phone are required, the

remaining fields are optional.

To add a contact from the Shared directory:

Select the Add Contact icon ('*) in the upper left side of the window.

In the Select User Type window, select Add Shared User.

V) Select User Type

I £4t Add Shared User ||

X

Cancel

In the Add Shared User window, select the field to search using the drop-down menu.

() Add Shared User [ [=1E3]

Name

W fucs

User ID
ucuser 1
ucuser2
ucuser3
ucuserd
ucusers
ucusers
ucuser?
ucusers
ucuserd
ucuser 10
ucuser11
ucuser12
ucuser13
ucuser 14
ucuser15
ucuser 16
ucuser17
ucuser 18

user|

Name
ucs user 1
ucs user 2
ucs user 3
ucs user 4
ucs user 5
ucs user §
ucs user 7
ucs user §
ucs user @
ucs user 10
ucs user 11
ucs user 12
ucs user 13
ucs user 14
ucs user 15
ucs user 16
ucs user 17
ucs user 18

[ @ search |

Desktop Phone
5001
9002
9003
9004
9005
3006
9007
9008
008
9010
s011
a012
9013
a014
9015
9016
a017
9018

Cellular Phane
011-122-2323
011-231-3432
011-234-3453
011-443-1234
011-555-5555
022-1222-4545
022-134-4534
012-1212-3434
011-233-1212
231-2323
011-222-2339
011-343-4545
019-232-4545
016-343-5679
016-345-3454
017-345-5476
018-343-1121

Email
ucuser 1@lg-nort
ucuser2@lg-nort:
ucuser3@lg-nort
ucuser4@lg-nort
ucuserSglg-nort
ucuseré @lg-norts
ucuser7@lg-norts
ucuser8 @lg-norts
ucuserS@lg-norty
ucuser 10@ig-nor
uauser 11@ig-nor
ucuser 12@lg-nor
ucuser 13@ig-nor
ucuser 14@ig-nor
ucuser 15@ig-nor
ucuser 16.@ig-nor
ucuser 17@ig-nor
ucuser 18 @ig-nor

Cancel

Enter the appropriate text to search within the field.

Click Search to display matching records.

Select the user to add and click Add; the contact record is displayed in the Not Assigned Group
in the Presence window.

To add a new Private User:
Select the Add Contact icon in the upper left side of the window.

In the Select User Type window, select Add Private User.
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V) Select User Type E|

|. £4t Add Shared User |

I 24t Add Private User ||

Cancel

In the Add Private User window enter the contact information (Name and Office Phone are the
required fields).

(V) Add Private User E|
= Name Mew Private User 1
= Nickname Mew Private User 1
= Office Phone 4200
= Cellular Phone 000-393-0000
= Office Mame
= Office Department
= Office Fax
= Office Address
= Harme Phone
= Home Address Hogye-1dong, Donan-ou, Anyang-shi,Kyungi-do|
= Email
. 0K | Cancel .

Click OK to store and display the contact record. The new contact is shown under the Private
group and stored in the Private User directory.

To delete a contact from the Presence window:
Right-click on the desired record.
In the popup menu, select Delete User.

Click “Yes’ to confirm the deletion.

NOTE

Deleting a Private contact from the Presence window also deletes the record from the Private
User directory. Deleting a Shared contact only removes the record from your Presence
window.

You may also view all the information on the contact. To view Detailed Information:
Right-click over the desired record,

Select Detail Information to display the contact’s Detail Information screen. The information
for a Shared user includes the user’s picture and schedule for the day. The information in the
window is the same as the Add Private User window shown above.
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X

(5] Detail Information

A

Today's schedule

= Marne |ucstester12 |
= Mickname |ucstester12 |
= Stationfumber  [1112 | &

Station Mumber2 | |

Station Mumber3 | |

= Office Phone [ +82 (031) s054-0m2 | (&
= Celusr Phone  [010-0000-0012 |=
= Office Mame |Er|cssnn-LG| |

ffice Department |undefined

Pasitian |

Office Fax [

Hame Phone |+82 (031) 0000-0012

Home Address |

|
|
|
Office Address | |
|
|
|

= Email |uc5tester12@u:app.cum

Time | 1&53  Time zone  {GMT+09:00) Korea Standard Time oK

6.1.1.2 Organizing Contacts by Group
For easier management, the Presence contact list can be divided into groups. Groups can be
added, deleted, renamed and contacts moved from one group to another. Initially, all Shared
contacts are placed in the Not Assigned Group and Private contacts are displayed in the Private

group.

- ].+==E|

~
Group Mot Assigned (20)

c

1.0ffice Contacts [2)

= 2.Private Contacts (£}

ucstester1z { _—
- Kahn

E ucstesterl3 L

- Good day

i

ucstesterl =
- Offline

To add a group:
1. Selectthe Add Group icon.

2. Type the new group name desired.
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() Add Group

® Group Mame |

[ 0K H Cancel ‘

3. Click OK to add the new group.

To rename a group:
1. Right-click on the desired group, the pop-up menu will display.

2. Select Rename Selected Group.

[v) Bename Group

= Group Mame |1, Office contacts

[ ox [ concat |

3. Enter the new group name and click OK button.

To delete group:
1. Right-click on the desired group, the popup menu will display.

2. Select Delete Selected Group.

NOTE

All contacts must be removed from the group before it can be deleted. Note the predefined
Not Assigned Group cannot be deleted.

To move a user to another group:
1. Right-click on the desired user, the pop-up menu will display.

2. Select Move Selected user to.

3. Select the group where the contact is to be moved,

OR

4. Drag and drop the user name to the desired group.

6.1.1.3 Searching the Presence Window
You may query the Presence window to locate a contact quickly. The UCS Client will search
the contacts listed in the window. Text entered in the search box is compared to the Name,
Today’s message and Desktop Phone 1 fields in each record. If no matching records are
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found, you can extend the search to all records in the Shared directory or, if enabled in the
LDAP database.

ﬁl |1+I!+==@

S

-~
Group Mot Assigned (20)

S

1.0ffice Contacts (%)

[= 2.Private Contacts (&)

s ucstester12 t =
R - kahn A
ucskesterld L =
E - Good day -

To search users in the Presence window:
1. Enter the appropriate text to search.

P

" |ru:|t| x (&M B2

i

(n

G

1 Search Shared User
 Search LDAP User

* If no matching records are found, extend the search to the Shared or LDAP database:

2. Select Search Shared User or Search LDAP User.

(Y] Search Shared User 0 Bearch LOAE User
HName e [user |[2 search | | | &4 search
User ID Name Desktop Phone | Cellular Phone Email ~ L Phiors Wit Lol Phone: Emall
1 uaserl  ucs user 1 001 0111222323 ucuser 1@ig-nort
2 |[& o) @) ucuser2  ucsuser 2 3002 011-231-3432  ucuser2@ignort
Y B oo ucusers o1 53 ucuser3@ig-nort
4 of | | ucuserd  ucsuser 4 3004 011-443-1234  ucuser4@lg-nort
5 uaserS s user § 005 011-555-5555  ucuser S@ig-nort
5 Ucusers s user 6 3006 0116666661  Lcuser6@ig-nort
7 ueuser7  ucs user 7 3007 022-1222-4545  ucuser7@ig-nort
8 Ucuser8  ucs user 8 3008 0221344534 UcuserS@ignort ||
3 uasserd  ucsuser 9 003 01212123434 ucuser9@ig-nort
10 Ucuser1d  wcs user 10 3010 011-233-1212  ucuser 10@lg-nol
1 ucuser1l ucsuser 11 011 231-2323 ucuser 11@lg-nol
12 ucuser12  ucs user 12 2012 011-222-2389  ucuser12@ig-nol
13 ucuser13 ues user 13 013 011-3434545  ucuser13@igna
14 Ucuser1d  ucs user 14 014 019-232-4545  ucuser 14@lg-noi
1 iriearS s user 15 an1s N16-242.5670  iocertS@lonm %
@ |ucsusers =2
& | ao03 ¢ B
Close | flase |

* The search results window displays.

3. From the results window, right click to display the actions popup menu as shown below.

» SHARED USER POP-UP » LDAP POP-UP
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(% Make & Call v g @00 | (o Make A Call || E2-31-a50-78s1
Scheduled Dial 000-333-3333 g Email E 015-450-7851
2 Email [ 7Iv-T7TT-8588 &dd Private User
Detail Information far 000-333-4444
Today's Schedule Info

6.1.1.3.1 Search Shared User
The Search Shared User window shows IM status, phone status, Webcam status, User ID,
Name, Desktop Phone, Cellular Phone, Email and schedule status and features of the
Presence window.

() Search Shared User g@@

Name | [ues user | [ search |

User ID Name Deskiop Phone | Cellular Phone Email o]
011-122-2323

ucs user 1 =2
£ | 001 ¢ ® (™)
Close
NOTE

Presence status in the Shared and LDAP windows does not automatically update, the display
indicates the status when the user queried the database.

If the number of queried users exceeds 100, the first 100 results will be shown, and any other
results will be shown on subsequent pages.

vl Search Shared User

S e un b e

I Toaak: 115 Page: 1 & I

B |veme (=
£ | 9001

o
E
E

i

6.1.1.4 Managing the Private User Directory

The Private User directory is a list of contacts you can enter or import from an external Contacts
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database. When initially entered, these contacts are listed in the Private group of the
Presence window. In addition to adding and deleting a Private User contact, these contacts
can be edited, all Private User contacts can be deleted and the contacts imported or exported
to databases including Outlook, Excel, Goldmine or ACT!.

=l Private (3}

& uu
N -oifine| (2 Make A Call »
Scheduled Dial
A uiz @ sMms
EN - offine
=@ Email
Detail Information
N
3 - cifine Mava Selacted Userta
Delete User
= aaaallLFFFFFFFFfg Delete Al Private Users
“ METF Edit User
EN - offine View R
Sort » ¥
: 0

To edit a user record:
1. Right-click on a record; the pop-up menu will display.

2. Select Edit User from the popup menu.
3. Modify the user’s information

4. Click OK to save.

To delete all the Private User contact records:
1. Right click on any contact or group.

2. Select Delete All Private Users from the popup menu.

3. Click Yes to confirm.

6.1.1.4.1 Importing and Exporting Contacts
Private User contacts can be imported from and exported to other contact databases such as
Outlook, ACT!, Goldmine and Excel. When contacts are imported, the contact records are
placed in the Private group and can be moved to a different group as desired.

To import contacts from ACT!, Goldmine, Excel or Phontage:
1. Select Import Contacts from the Tools menu.

62

iPECS UCS Client for PC User Guide - Issue 4.1



|
b

(&) ucs client

File wiew | Tools | Help
o V) BS0 B0 4d0
|+ File Send L - @
|igl Sharing [ -
| sms il
Schedule
& Video 3
A+ B 22
L 4 Presence =&
P S
Phore o]
® Gra
Logs
&' # 1.0 IM Log
Import Contacts 3
_ Bazp
c Export Contacts 3
Audio Conf, o
Favorite Links LN

ucstester13 L = 1
- aood day o

2. Select the database type.

3. After importing, the Import Result window displays and the imported contacts are displayed in
the Private group.

To import contacts from Outlook:
1. Select Import Contacts from the Tools menu.

2. Select Outlook

3. Select the Outlook contact folder, the Outlook access popup displays.

(%) Folder Selection

= #Outlook®
=1-{CT) Personal Folders
| Deleted Items

I Inbaox
I3 Outbox

[ Sent Items
[ Calendar
=l ontacts
(= Journal
[ Mates
ICT) Tasks

[ Drafts
{3 Junk E-mnail

[ 0K H Cancel l

4. Check Allow access for, select a time and click Yes.
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Microsoft Office Outlook

A program is trying b0 access e-mail addresses you have
stored in Outlook. Do you want ko allow this?

If this is unexpected, it may be a virus and you should

X

choose "Mo",
Allow access for 1 mirute v
[ es ] [ o ] [ Help

]

The Import Result window displays and the imported contacts are displayed in the Private

group.

NOTE

If No is selected in the Outlook access popup window, the import will fail and you will receive an

unknown error notification.

To import contacts from a CSV file:

Select Import Contacts from the Tools menu.

Select CSV.

Select the CSV file to import.

CSY Field Mapping Table

= C5VFile Hame |D:Wphonebook. csv
Mapping Table
UCS Field CSV Preview
Name Oscar
Nickname Memo
Cellular Phone 010-1111-2222
Email X00@XXX.com
Home Telephone +82 (02) 33334444
Home Address Some Address
Office Name Company
Office Department Position
Office Phone +82 (031) 55556665
Office FAX +82 (031) 55550000
Office Address Some Address
hittp: ffx oo
+82 (032) 77778888
+82 (031) 55550000
England
001-002
London
Somewhere
Some Address
3000
26 Private User

The CSV Field Mapping Table window is shown.

| Loaa |

| View on Notepad |

CSv Field
fame |
emo |
[celiar =¥
I [
[rome =]
[address |
[Compary Name _v] ¥
[1bPositon | I
=S
FAX -~
-
fFomepage ]
Etc -
FAX hd
oy =]
[Zocode -]
city -
State -
[ddess =]
wsieex =

Arrange the CSV Fields.
Uncheck fields not to import.

Click the Import button.

To export contacts to ACT!, Goldmine, Excel, or CSV:
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1.

2.

Select Export Contacts from the Tools menu.

In the popup Natification window, select Yes to include Shared User contacts or No to export
Private User contacts only.

. Select the database type. The export process starts and a notification window appears when

completed.

¥]' Notification

= Do you want to include the shared user?

NOTE

When using Excel reporting, the Excel program must be closed before starting to export data.
If the program is not closed, the user will receive a popup message requesting Excel to be
closed.

() Information

@

Excel is runnig. Plase close it and try again.

0K

To export contacts to Outlook:

. Select Export Contacts from the Tools menu.

In the popup Natification window, select Yes to include Shared User contacts or No to export
Private User contacts only.

. Select Outlook for the database type.
. Select the desired Outlook contact folder, Outlook access popup displays.

. Check Allow access for, select time, and click Yes. The export process starts; a notification

window displays when completed. The export process starts; a notification window displays
when completed.
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With the Phone mode enabled, refer to see Section 3.2.3.2, you have access to all of the
IPECS system features as well as the features available to traditional iPECS IP Phones, with
the few exceptions based on the differences discussed below. The fixed feature keys operate
in the same manner as in the iPECS IP Phones except the mouse is used to select dial pad and
feature buttons. For operation of the features, refer to the iPECS IP Phone User Guide.

AEONE 1132 (T)

H

13 94 13 15:11 i
' Vo Vo

= l:_. 1 \ a%c _..' __D%F ) | TRans || REDIAL |
p—P—P— FWD COnF
(o (o) e
\er/ ) o) (oo [ o |
@O@ ==
- o-a-ak s
I X ) '\ 0) [ # ) | seeep || osave |
L @ =P (%)
= |:| SPER Hold

With the exception of the following User Programming items, the Phone window screen allows
complete access to all the features and resources of the iPECS host system.

Station Answer mode — only Privacy for the Station Answer mode; Intercom Call Announce
is not supported for the UCS Client.

Station Ring Download — UCS Client users can change the ring tone files stored in the
iPECS UCS Client folder; ring tone files cannot be downloaded from the iPECS system.

Audio source control — UCS has a single audio path, and cannot support the dual path
(headset and speaker) controls available with the traditional iPECS IP Phone.

There are three Speaker volume settings for ring, internal call volume, and external call volume;
the three volumes are saved and retrieved according to phone status.
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6.3 Logs Window

The Logs window displays the log of UCS services used by the UCS Client. The log identifies
the service type, name of connected party and time the service was employed. These logs are
stored on the UCS Client PC and can be searched or archived as a backup file in the UCS
Client folder.

Al et et

Service T... | Name Dake & Time (53

Phone Number: 1112

Contents: Hi. I reEeived YOUF MEessage.
[2013-09-13 R = 2:33:00]

- SMS 2013-10-16 2=
= { -
e = Receive ucskesterl3 12057

2 Phone Number: 1113

Contents: Are you ok. Today is Friday
[2013-09-13 2 = 2:32:00]

% Mote Send  ucstesterld 013-10-16 2%

3 5:00: 56
Contents: I received your message.

G Nate testerl? 2013-10-16 2F
Receive UEstester 55926

Contents: Hi, This_is a test message.
[2013-10-16 2 = 5:59:00]

57} Haote ) Z013-10-16 2=
Receive 5:59:25

Contents: Hi, I'm noticed a message. ok !

[E4

In addition, by right clicking on a record, the popup menu similar to the Presence popup is
displayed, see Section 6.1.

Services logged are:
¢ Call (Incoming, Outgoing, Conference Room)

* Instant Messaging (IM)

* Application Sharing

* Desktop Sharing

*  Whiteboard

* Video

* Presentation

* Remote Monitoring (Requesting)
* Remote Monitoring (Be requested)
* Web Push

* File Send

* SMS

* Note

* Missed Call

* Memo
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To search the Logs window:

Select the Service Type from the drop-down menu.

Enter the appropriate text to search.

NOTE

If more than 2000 records are stored when you login, a Backup window will display indicating
the Logs window should be archived. This is needed to minimize any effect a large number of
logs may have on performance of the UCS Client and other Windows applications. The
archive file is named and saved to a backup directory in the UCS client folder. The backup file
name includes the date as in the following example, 20080325143309092.xml|

To view the backup file, double click the file name in the UCS Client folder. The file is displayed

with the default browser as below.

<2 C:\Program Files\UCS, Client\backup\& 01 Recentlog_ucuser1_20080414192023066.xml - Microsoft Internet Explorer g@@
Fle Edit view Favortes Tools  Help

O Back ~ >,

A ~ A n
ﬁ Igl §) - Search 7 Favarites & -z M -

a3

&] Done

Address M C:¥¥Program FilesWUCS Client Whackup 2 HRecentLog_ucuserl_20080414192023066. xml e a Go  Llinks ?
Recent History
Service Type Name Date and Time Description
Missed Call UCS User 14 20080414T11:32:35000 Phone Number: 4113
Call {Inbound) UCS User 14 200804147 14:46:46000 Phone Number: 4113
Call {Outbound ) UCS User 2 200804147 14:57:17000 Phone Nurmber: 4101
Call {Outbound UCS User 4 200804147 14:57:17000 Phone Number: 4103
Call {Conference) Mo information 200204147 15:24:04000 Room MNumber: *591
Call {Outhound) UCS User 3 200804147 15:35:51000 Phone Number: 4102
i Phone Nurmber: 4102 Contents: Hi
SMS Send WS User 2 200804147 15:42:50000 ~ this is a test message,
Phone Number: 4102 Contents: Hi
SMS Receive UCS User 2 200204147 15:45: 14000 ~ I'm received a message, ok |
[4/14/2008 12:09:00 PM]
Mote Receive UCS User 14 200804147 15:49:55000 Contents: kkkkkddeddddzlkldkdelkdele
Mate Receive UCS User 3 20080414T 15:49:53000 Contents: make a cal ma ...
Missed Call UCS User 3 200804147 16:01:31000 Phaone Number: 4102
Call {Outbound) UCS User 2 200204147 16:02:50000 Phone Number: 4102
Call {Outhound) UCS User 3 200804147 16:03:07000 Phone Nurmber: 4102
Call {Inbound) UCS User 3 200204147 16:13:28000 Phone Nurmber: 4102
Call {Inbound) UCS User 2 200804147 16:14:06000 Phone Number: 4101
Call {Outbound) UCS User 2 200204147 16:15:23000 Phone Number: 4101
Call (Outbound) UCS User 4 20080414T 16:15:45000 Phone Number: 4103
Call {Outbound) UCS User 2 200204147 16:26:29000 Phone Nurmber: 4101
Call {Outbound UCS User 3 200804147 16:26:29000 Phone Number: 4102
Call {Outbound) UCS User 4 200204147 16:26:20000 Phone Number: 4102
Call (Inbound) UCS User 3 20080414T 16:42:46000 Phone Number: 4102

"¢ My Computer
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6.4 Selected Contact Window

The Selected Contact window displays immediately below the main window and provides basic
information about the highlighted contact. The window includes icons to establish a
collaborative session with the contact. Highlighted icons indicate the communication modes
available to the contact. Selecting an icon initiates the communication. The Selected Contact
window can be disabled if more space is desired in the main window, see Section 3.3.1.

3 Mo information

6.5 Organization Window — (P)

The Organization window displays the Organization Chart from the UCS Server in a split screen
showing the Organization hierarchy tree and organization members. Members are shown in a
tabular format with presence status. Tools allow you to customize the view with the
organization tree to the left, right, above or below the member table. In addition, the various
presence states (IM, phone, video, etc.) can be eliminated from the view and a sorting order for
the members (IM, Phone or Name) can be selected. Manual and immediate refresh buttons

( — permit the user to refresh the display immediately or allow timed updates.
=
) @M L ]
B E5 RED
Undefined
ﬁ UC&Application
ucp
1]
PR E =
96
Mame Skation ... A
_ 7 ucskestersa 1153 @
\" 76 | B ucskeshersd 1159
77 ucstesters 1106 @
78 ucstestersd 1160 @
79 ucstester? 1107 @
an ucsteskerd 1108 @
a1 ucstesterd 1109 @
a2 usel 1892 @
a2 SEAH |2 290 ® b

To use the Organization window, the Organization Chart must be established and use
authorized by the iPECS UCS administrator.

To view the Organization window:
1. From the View menu, select Organization.

File | Wiew | Tools Help

Wiew Selected User Detall Infarmation
Call Assistance

k
{ Restore Default Window H

g

x

[
=

Quick Call Contral Bar
Phone Tab

”nl-:@

< <][<]

Organization
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2. Logout of the UCS Client and log back in; the Organization tab will be shown in UCS Client
automatically.

6.5.1 Searching the Organization Chart

A department may be selected to view all the users in a department. In the upper right of the
Organization window is the Search text entry box. To search for a particular user, enter
search characters in the box and matching entries will be shown in the Organization window.
You may right click on a contact to receive popup menus as with the Presence window, Section
6.1.

[ -)[Ef3)(c
- Ericsson-LG ~ Ma...
UCS User
CM User
# Related Coi
SMB) SMB
SMB) SME -
SMB) PLM 1
# Enterprise)
H CTO
UCS Test G
+ Enterprise)
# Enterprise |
GPC

Enternrizal ¥

< >

oW oW g

o I R W R N W R S ]

o

(s )
EE EE E E

-
(=)

B r I r T

A LA [ A A [P

-
=y
— =

-
ra
]
K

WO OW WD WD W0 WD WD WD MDD

-
[
=
[
e
h

NOTE

The UCS Client searches for a match in the Name, Desktop Phone, User ID and Cellular Phone
fields, in order.

6.5.2 Window Appearance

Tools in the Organization window allow the user to change the appearance of the window as
well as the presence information shown for each contact.

To modify the appearance:
1. Selectthe Screen tool at the upper left.

Qrganization Top/User Bottom
Organization Left/User Right
Organization Bottorn/User Top

Organization Right/User Left

EDBO

Custornize Colurmn View »

Saort 3

2. From the Screen tool menu, select the desired screen orientation. The Organization window
will display with the orientation selected.
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Left/Right View Right/Left View

(1w -)(E)[c) (I -Eca)
= Ericsson-L ~ Na.. &[D. |4 | = Ericsson-L &
UCS User 1 9 1 UCS User
CM User 2 . 9. 2 CM User
Related Col 3 9. 3 Related Coi
SMB) SMB 4 g 4 SMB) SMB
SMB) SMB = < o 5 SMB) SMB
SMB)PLM T .~ o z SMB) PLM T
Enterprise} = ; s 7 Enterprise)
1o : T T cTo
UCS Test G 9 - 9"' 9 UCS Test G
Enterprise) o Enterprise}
Enterprise | 1 -2 10 Enterprise |
GPC 1 - 9. 11 GPC
Enternricat ¥ 12 & i - 9 124 = Entarnrizal ¥
12 L9 He 13 -EHM *
Top/Bottom View Bottom/Top View
TREE6] (@)
= Ericsson-LG e’ Deskto. .. -
UCS User 1 9004
CM User 2 9001
Related Company 3 9010
SMB) SMB Sales . 4 4 9071
5 9012
Deskto ~ 5 9013
1 9004 7 9014
2 9
3 3010 = Ericsson-LG
2 90 UCS User
5 9012 CM User
o Related Company
< =0t SME) SME Sales A
7 9014 v >

To modify the presence information shown in the window,
1. Select the Screen tool at the upper left of the window.

2. From the Screen tool menu, select Customize Column View.

3. Inthe popup menu, check the box in front of each item to display for the contacts.

Index

M Status

Call Status
Video Status
Desktop Phone

L e .Y

Today's Schedule Status

To change the sorting of the window,
1. Select the Screen tool at the upper left of the window.

2. From the Screen tool menu, select Sort.

3. Inthe popup menu, click the sorting column.
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Chapter 7
Quick Call Control Bar

With the Quick Call Control Bar at the bottom of the main window, you can make and receive
calls. The text box displays the names and numbers from contacts in the Presence window or
you may dial a number from the Simple dial pad popup. This control bar consists of the
Simple dial pad icon, drop down contact list, and Call and Speaker controls.

Placing a call from the Quick Call bar is quick and efficient.

To place a call using the Simple dial pad popup:
1. Launch the simple dial-pad popup using the dial pad icon.

2. Click on digits to dial the number. The digits display in the pre-dial box.

1) (2) (3) |
1 4 5 ﬁ rer
e = W
lZJ) L 8B 9
x)(0)(#)[fe
; : []z]
Dial pad icon |E

3. Press the Call button to place the call.

To place a call using the drop down contact list (shows a list of contacts from
the Presence window):

1. Click on the drop down arrow to access the contact list.

2. Click to select the desired contact.

To end the call:
1. Click on the speaker button.

Calls can be placed from other applications while the UCS Client is active or minimized.

To place a call from another application:
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7.2

. Copy the desired digit string (Ctrl + C).

. Pressthe “Ctrl + Shift + D”.

Or

. With the Call Assistant displayed, drag the mouse over a number while holding the right mouse

button.

Receiving a Call

When a call is received, the phone will ‘ring’ and the selected caller id popup will appear. The
window shows the caller id delivered from the iPECS and the name associated from the
Presence window. If the UCS Client is minimized, the popup will display the incoming call
information or the iPECS UCS Client icon in the Windows tray will flash to indicate the new call.
In the latter case, iIPECS UCS Client must be activated to answer the call.

To answer a call with the UCS Client active:

. Click on the speaker (42 ) button.

To answer the call with the iPECS UCS Client minimized:

. From the Caller Id popup, click the Answer button.

B inbound x

ucstesterl3
- 1113

\: TRAMNS QO voicemail

N Ring Mute

To end the call with the iPECS UCS Client minimized:

. Click the Reject button.

Or

. Activate the UCS Client and click the Hangup button.

B nbound @

ucskeskerl3
- 1113

2 TRans Qo vaicemal || Hod

\E Park @ Recording & MUTE
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Chapter 8
Tools Menu Call Features

From the Tools menu of the main application, you can access the Call menu. In this menu are
tools designed to enhance group collaboration and simplify use of calling features.

8.1 Scheduled Dial

Scheduled Dialing permits you to enter a phone number for dialing at a later scheduled time.
When the scheduled time is reached, the Confirm window appears, you must confirm before
dialing will begin. The Scheduled Dial window contains a list of the phone numbers and
schedules entered. The window includes icon tools to manage scheduled calls.

(U] Scheduled Dial Manager

[EL add [E Edt | < Delete | " Delete | 57 Cal
Date & Time ame Phone Mumber Company
s 4/14/2008 4:27:44 PM UCS Liser 3 4102 LG-HORTEL
@5: 414/2008 312938 PM UCS User 2 4101

Lia-MORTEL

To access the Scheduled Dial window:
1. From the Tools menu, select Call.

2. From the Call menu, select Scheduled Dial to display the window.
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To add or edit a Scheduled Dial:
1. Click the Add or Edit icon on the Scheduled Dial window; the Scheduled Dial Manager popup
appears.

(U) Sche .aled Dial Manager

NS User 2

=¥ Phone Mumber 410 L
Company |LG—NON_ |

= Wate & Time |D4,|'15,|'2DDS 1238 PM -t

2. Enter the Name an@ Company.
3. Enter or use the drop down menu and select a Phone number (required entry).
4. Use the pull-down to schedule a Date & Time.

5. Click OK to save.

NOTE
Each Scheduled Dial must have a unique scheduled time. Duplicate schedule times are not
allowed.

To delete an entry from the Scheduled Dial window:
1. Select Delete or Delete All; confirm the record deletion.

2. Click OK.

When the scheduled time is reached, the Confirm window will appear. You must confirm by
selecting OK before dialing will begin.  You can select Snooze to delay the call.

(5) Confirm I* 4ling

D CS User 2

Mame

umber

Company

Reserved Time @ 4
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8.2 Recorded Call Playback

The UCS Client allows you to record a conversation onto the client PC hard drive. Recorded
conversations can be reviewed after recording. In addition, text or voice comments can be
added to the recording and sent via email as attached .wav files. Using the tool icons at the
top of the Recorded Call window, you can delete, add a comment and E-mail recordings.

Calls are recorded with controls in the Call View, see section 13.

To playback a recorded call:
1. From the Tools menu, select Call.

2. From the Call menu, select Recorded Call to display the Recorded Call window.

3. Select the desired recording.

4. Use the reverse, play, pause, forward and stop playback icons to control the playback.

8.3 Auto Call Recording

When enabled in the iPECS system, conversations of the UCS Client and/or other iPECS users
are recorded to the hard drive of the UCS Client PC. Other stations in the system may be
assigned to record conversations to the UCS Client, “3rd party recording”. For proper 3rd
party recording, the iPECS UCS Client must be idle.

8.4 Flex Buttons

The Flex Button window provides access to 48 Flex buttons. Each button includes a status
icon, which displays the status of the CO Line or station associated with the button. The
button also displays a designation from the iPECS system database, such as CO 001, LOOP,
etc. Flex buttons of the UCS Client may be assigned to activate other iIPECS system features
such as dial a Station Speed Dial.

|' . €O 001 H . €O 002 H . €0 003 H . CO 004 ‘ A
v o o v
|' = CO 005 H ~. CO 006 H = €0 007 H ~. CO 008 ‘
v o o v
(=, cooog |[=, co 010 |[ =, LooP |[=, LoOP |
b4 Y Leem Tunk || b4
|w Hu Hu Hu ‘
e o o Jo |
o © o o \

w

To enter and assign a Station Speed Dial to a Flex button:
1. Rightclick on an assigned Flex button.

2. Select Set Attribute; the Flexible Button program screen will display.
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8.5

8.6

. Enter the number to be dialed.
. Click the CO Call checkbox if the input number is not a station number.
. Enter an optional Description (display) label for the Flex Button.

. Click the Save button.

NOTE

If a Flex button is assigned for Paging, the UCS Client must be off-hook prior to selecting the
Page button. The UCS Client must be in the idle mode to assign a Flex button.

Voice Mail Server Selection — (P-CM)

When multiple voice mail servers are associated with the UCS Client, the VM Selection window
permits access to the various mail servers.

(vl ¥M Selection g|

= Select the WM you wish to access
*620 (WSF Type) e

FT
[Me23 (UMs Type)
*624 (External YM Tvpe)

0K ] I Cancel

NOTE

A server can be selected as default, in which case this window is not shown when selecting the
VM icon in the Message and Status icon tool bar.

To access the VM Selection window:

. From the Tools menu, select Call.
. From the Call menu, select VM Selection to display the VM Selection window.

. Select the desired Voice Mail server from the drop down list.

Favorite Contacts

Favorite Contacts allows you to call and transfer calls easily using the Call window.
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(1) Select Member &

() Presence
Member List + add
User ID Hame Desktop Phone A~
Nird ucusers UCS User 3 4102
& f-) R ucusers UCS User § 4104
N3 ucuser1s UCS User 13 411z
A [ |R) ueuser? LICS Lser 7 4105
A ucuserd UCS User 8 4107
ra ucuserd UCS Liser ¢ 4103
ra ucusers LICS Liser 9 4108
umuserll UCS User 11 4110
rs ucuserls UCS User 15 4022
s umuserl4 UCS Lser 14 4113
ucuser? UICS Lser 2 4101 v
Added Member List * Delete
User I Name Desktop Phare
0K Cancel

To add lists to Favorite Contacts:

1. From the Tools menu, select Call > Favorite Contacts > Favorite Contact, the Select Member
window will be shown.

2. Select the desired Member(s) and press the Add button. The contacts are added at the
bottom of the Select Member window.

8.7 Step Call

Step Call allows the user to make calls to numbers from a contact list sequentially. Users

create a list of contacts for outbound calling, which can be added one-by-one or imported from
a file where the file extension is ‘.scd’ or ‘.csv'.

(U] Step Call

File Options

E\'_ Add | X Delete 4 Delete [Z File Send

Name: Office Name Office Department Phone Number Result Mema
2 Userd 010-2338-2222 fl &
3 lsert LG 031-450-8789
4 |Userz Rorte] 4544
5 |UCSUser 10 LG-HORTEL BCS 4109
(T o]
I ﬁ Step Call Start] { f Make a Call l { u—‘; Call Next l I G Drop l

Information Wrap Up oo Signing
= Mame =Resul @ Success (" Failure
= Office Name " Memo
= Office Department:
® Fhone Humber (3610

Auto calling is stopped,

To add contact(s):
1. Click the Add button in the toolbar.
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Enter values into the edit box at the bottom of the Step Call Information window.

To add contact(s) from a database:
From the File menu, select Load Step Call Database.

. Select a Step Call Database.

Options

Create a Template File

Load Step Call Database

NOTE

You can create a Step Call Database template file with a file extension of .csv (select File >
Create a Template File).

To add contact(s) from the Directory:
From the File menu, select Add List from Directory, the Select Member window will be
displayed.

. Select and add the desired contact(s) from the Select Member window.

Options

Create a Template File

Load Step Call Database
| Add List frorn Directaory

Save the current list &s,.,

To make an outbound Step Call:

. Select a record in the outbound calling list.

Press the Step Call Start button

. The phone number of the selected record will be dialed.

. After the call is completed, the ‘Result’ and ‘Memo’ can be created; the interval between

calls is set as shown.
* Result input selections include:
— Success: @,
— Failure: &
* Ifamemo is saved, the & symbol will be displayed.

e If| o~ smns | js pressed, the current time and user name will be entered automatically.
The next record on the list will be selected automatically.

. Step calling stops when the end of the calling list is reached,
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OR

. Step call can be stopped by pressing the | 32 step call stop | button.

Alternate method for making a Step Call:
. Select a record from the outbound calling list.

. Press the Make a Call button| ¢ mMakeacal | the call will be initiated.

. When the call is terminated, the user can enter the ‘Result’ and ‘Memo’, if necessary.

To end a Step Call:
. Pressthe ‘Drop’ button| worp |

To create a Template File:
. From the File menu, select ‘Save the current List As-’.

In the dialog box displayed, enter the desired file name and click on the OK button.

. A .csv file will be created with the designated name.

To use the created Template file:

. Open the template with ‘Excel’, ‘Notepad’, etc.

. Enter values (Name, Company, Department and Phone number).

. When finished, click Save.

. Referto Load Step Call Database (.scd, .csv) above to download the file.

To save the current Calling List to afile:
. From the File menu, select ‘Save the current list As--".

Options
Create a Termplate File

Load Step Call Database
Add List from Directory

| Save the current list As. .. |

In the dialog displayed, enter the desired file name.

. Click the OK button.

To send the current Calling List to others:
. From the toolbar, select File Send.

. The UCS Client will save the current list as a temp file and attach it as the file to send in the
File Send window.
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The Call memo is designed for noting important information during a call so that the information
can be referenced later. The Call memo is retained in the recent Logs. You can confirm and
modify the memo in the Call Memo window. The following methods can be used for activating
the Call Memo window:

(U] Call Memo

Add Call Memo @

= Phone Mumber |304D |

= Memo

[Csrheduled Dial [+ add |

Display Registered Call Memo

6182009 5:34:51 PM
1 |[Sales Meeting at 5:00 PM

[ % Delete |

pr—

From the File menu, select Setting > Call Popup>Show Call Memo Window Automatically.

. When a call is placed, the Call Memo window will automatically display.

To activate the Call Memo window from the Call Tab:
Click on the Call tab when on a call in UCS Client.

Select ‘Add Call Memo’ or ‘Show call memo’.

& By B ® = B O

3040 - Call is conrl

"5 File Send

&, Sharing 3
® video »
2 Send Email

Detail Information
Schedule Info
Add Call Mermo
Show Call Memo

* Add Call memo —a call memo can be added with CID information.

¢ Show Call memo - displays call memos already created.

To activate a Call Memo window:

If the option ‘Call pop-up’ is set and the UCS Client has Call memos regarding the current call,
the Call Memo window can be activated by clicking on the icon at the bottom-right of the call
pop-up window.
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NOTE
Prior to closing the Call Memo window, the memo content is summarized on the screen.

To add a new Call Memo:
. Open the New Call Memo area.

* ) Open this area.

. @ Close this area.

. Enter the memo contents.

. Click on the Add button|  + add | .

. The saved memo will be located in recent Logs, and can be viewed when a call is placed from
the UCS client.

Using Scheduled Dial:
. Verify the ‘Scheduled Dial’ checkbox is checked [+].

. Click on the Add button.

NOTE

The Scheduled dial will be activated with the user name, phone number and company name in
the Call memo; saved Call memos also will display in this area, and can be modified or deleted.

To modify a saved Call Memo:
. Click on a Call memo to be modified; the memo will be opened for editing.

. Modify the content.

. Changes will immediately update in the Call memao.

To delete aregistered Call Memo:
. Select the Call memo.

. Click on the Delete button | x pslet= | .

The Call Memo tab can be used to manage comments from multiple users such as during a
conference call. Each user is separated with a tab in the Call Memo window.

To Close a Tab:
. Click on the Close button, (3] , within the appropriate tab.

NOTE
If only one tab is open, the close button will not be visible.
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To select a different opened tab:
1. Click on another tab to add Call memos for others on the call; changes are saved and
displayed in a new Call Memo window.
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Chapter 9

Scheduling Appointments — (P)

In the Schedule window, you can view, add and modify scheduled appointments.
Appointments can be viewable by and E-mailed to other UCS Client users. Appointments are
displayed in the Schedule window, which is divided into 4 main components. At the top of the
window are the appointment management tools. In the upeer right is the monthly calendar,
used to select appointment dates. In the right left is the folder selection area used to select
appointment folders to display in the Appointment window. Finally, to the right the
Appointment window displays the summary of the day’s appointments.

0] Schedule E@@

Exchange Server Setting
Day wiork Wesk | Week Month Year Tirme Grid | ) Refrash
Wednesday, July 28 ~ll4 July 2013 August 2013 »
SM Tw T F S SMTWw TF S
1z «[12345867
34s5clls oo = 5 ow1121314
9 0a w1011 12 13 14 15 16 15 16 17 18 19 20 21
» 1716 1920 21 22 23 = 72 23 24 25 26 27 28
24252627 2892930 2930 3
1 o0 [|tew Model Laurhing Show (5e0u)
20 September 2013 October 201F
SMTwW ITFS SMTWTFS
11m 1234 1
E 567891011 ¢ 2345678
12 o Qualty Mesting (Seoul) Y12 13 14 15 16 17 18 910 11 12 13 14 15
‘ . 19202122232425 ¢ 1617 181920 21 22
30 | | Qeulity Mestingin Gangnam 26 27 28 29 30 31 23 24 25 26 27 28
1m -
30
. Private Schedule
2 My Folder ]
E
3 00 | |Mew Requirement Meeting (Amyang) Shared Schedule
g | |Mew Renuivement Plsting - 310 Mesting room TesTt )
400 TEST2 Fa
30
5o Critical Desing Review (Anyang)
n | |302 Meeting Room
600
a0
7 v

The Schedule window can be accessed from the main application Tools menu or by clicking on
the calendar icon to the right side of the My Detail Information.

You can add, modify, delete and copy your private appointments or shared schedule
appointments in the Schedule Item window. For your private schedules, you have all access
rights to read, add, modify, delete and copy appointments. For shared schedules, you can
read all appointments and may have the authority to add, edit and delete Shared schedules as
well as your private schedules. In this window, the appointment is identified, scheduled and
other users identified for notification. In addition, a location and meeting content can be
defined.
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To add an appointment:
1. Select a date in the monthly calendar and click on the Add icon to display the Schedule Item -
New window.

2. Inthe Schedule Item window, complete all required fields.

() Schedule Item - New 3 @@
Folder Name
Subject MNew Appointment Subject
Location Mew Appointrient Location
Attendes(s) Mermber List (2) | + add || % Delete | | Others |
Nams Email
ucstester1s ucstester 1 5@ucapp, com
ucstester 16 ucstester L6@UCAP0, COM

[[] send Email to Attendee(s)

Start Date & Time | z013-11-07 v| B EE S [Jall day event
End Date & Time | 2013-11-07 | (0200 2% 5
[CIreminder:

0Open This Schedule to All Shared Users

My Presence for an Appainkment

My Presence After Expired

Mew Appointraent Contants|

o) o]

* The Subject and Location fields can be a maximum of 255 characters.
* Contents field can be a maximum of 450 characters.

* Up to 20 attendees can be listed. Each attendee must have unique E-mail address.

3. Setthe action for automatic My Presence update for this appointment. UCS Client will change
and return My Presence to the status selected from the ‘My Presence for an Appointment’ and
‘My Presence After Expired’ fields.

4. Click OK; the new schedule will be displayed on the calendar.

If the ‘'Send Email Now?’ box is checked, the schedule is added and your default E-mail client
opens with the attendees listed as receivers and the schedule attached. If MS Outlook is set
as the default E-mail client, ‘New appointment’ is displayed instead of ‘New email’.

NOTE

When there are several appointments that change My Presence at one time, the lower
schedule in the Today’s appointments list has higher priority.
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Other UCS Client users can view your private schedules when you allow it by checking the
“Open This Schedule to All Shared Users” box. If you check this box, other UCS Client users
can view your schedule and use it for presence information. If the date of the appointment is
today, your presence members can see that you have an appointment today as shown.

You can allow other UCS Client users to view all your private schedules by checking the popup
menu of your private schedule folder.

Private Scheduls |
A

Import From Qutlook
shared Schedule Export To Outlook
TESTL Open All Schedule to Presence Users
TEST2 = I

If you want to arrange the schedule with attendees, click the Others button, a popup menu
appears where you can start an IM session, Make a Call or check attendee schedules.

To view an attendee schedules:
1. Click the Add icon.

2. Select Attendees for the schedule using the Select Member window.

17 AR T hodubs Wit e

3. Click the icon of another user; the popup menu will display.
4. Click on a particular Attendee’s Schedule Viewer; the Viewer will display.

5. If the start date and end date of the appointment are the same date, the window will show the
day’s schedule of all attendees. Otherwise, it will show the day period schedule.

To edit a schedule:
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. Double click on the appointment in the Appointment window or select the appointment and click
the highlighted Edit icon.

. Select the Edit icon button to display the Appointment window
. Modify the information in the window, see Adding an appointment above.

. Select OK, the modified appointment is displayed in the appointment list.

NOTE

When you edit an appointment that changes My Presence, you cannot select options from My
Presence for an Appointment and My Presence After Expired drop-down list.

To delete an appointment:
. Select the appointment from the Appointment window; if you have permission to delete the
appointment the Delete icon will highlight.

. Click the highlighted Delete icon.

. Confirm to complete the deletion.

NOTE

When you delete the appointment that changes My Presence, a confirmation window will
display. If you click the “Yes' button, My Presence will be changed by the ‘My Presence After
Expired’ for the appointment.

To copy a schedule to another date:
. Select the appointment from the Appointment window; if you have permission to edit the
appointment the Copy icon will highlight.

. Select the highlighted Copy icon to display the Copy Schedule popup.

. Input any appointment edits and select new dates; the start and end dates and time are
required fields.

. Select OK, to copy the appointment.

NOTE

If the difference between start and end date exceeds 7 days or if the range includes selected
appointment dates, an error message displays.

An ICR scenario can be added to a schedule to be used as needed for routing incoming calls at
designated times.

To add an ICR scenario for a schedule:
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1. Right-click on an appointment where the ICR scenario will be added.
2. Select Add ICR Scenario; the ICR Wizard window will display.
3. Enter Scenario Name and assign a scenario destination (refer to Section 10.4.5).

4. Click on the OK button.

To remove an ICR scenario from a schedule:
1. Right-click on the appointment containing the ICR scenario.

2. Select Remove ICR Scenario.

3. Click to confirm the deletion.

IPECS UCS Server maintains two lists of schedule folders, a shared schedule and your private
schedule folders. Schedules in the shared folder are managed in the UCS Web Administration
by allowed users only. Schedules in My Folder are your private schedules, which you maintain
and manage. Appointments from the selected folders are shown in the Appointment window.
To select a folder check the box next to the folder name.

For each day, the window shows the appointments for all checked folders organized by date.
The list for each date can be minimized or expanded to display the summary.

The appointments for the current month contained in a schedule folder and displayed in the
calendar can be imported from or exported to Outlook. If you want to import or export
schedules for other months, simply change the month displayed in the Monthly calendar.
Items contained in an unchecked schedule folder cannot be imported or exported. Shared
schedules not managed by you cannot be imported to or from your shared schedule folder.

To import a schedule:
1. Right-click on a checked schedule folder.

2. Select Import From Outlook.

3. Select the Outlook schedule folder to import and click OK; the Import from Outlook window will
display.

NOTE
The Recurring column indicates that it is a recurring appointment.
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(V) Import From Outlook E]@@

£} Import M Cancel
Date 2011-12-01 ~ 2011-12-31
Select| Folder Mame Subject Start Date & Time End Date & Time | Recurring Open | Presence Update | When Expires Result
1 My Folder | Appointment & |2011-12-01 00:00 2011-12-02 00:00 (=] [ |oont Dan't
2 My Folder 2011-12-05 12:00 Busy Criginal
3 My Folder 2011-12-21 00:00 [ oot of office  [BeRightBack|
4 My Falder 2011-12-25 19:00 InaMesting  |Away

. Select each checkbox for the schedules you want to import.

. Click on the Open checkbox of other UCS Client schedules that you want to view.

NOTE

If ‘Open All Schedule to Shared Users’ is unchecked in the personal schedule settings, the
‘Open’ column of Import from Outlook will not appear.

. Set the action for automatic My Presence change for this appointment. The UCS Client will
change and return the My Presence selected from the Presence Update and When Expired
drop-down list. When finished making selections, click Import.

. The Import status displays in the Result column of the Import from Outlook window.

NOTE

If imported appointments contain text in HTML or Rich Text format, the text will be displayed in
plain text format.

To export the contents to Outlook:
Right-click on the checked schedule folder that will be exported.

. Click Export To Outlook; the Export To Outlook window displays.

. Click on the checkbox for the schedules to export.

. When finished, click the Export button; the Folder Selection window displays.
. Click on the target Outlook calendar folder to receive the export.

. Click OK to export the schedule, updating Outlook schedules.

Export status displays in the Result column on the Export to Outlook window.

NOTE

Recurring appointments cannot be exported to Outlook because of the applicability of existing
appointments.
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9.4 View Other UCS Client User Schedules

You can check other UCS Client user schedules if the schedules are enabled for viewing by
checking the ‘Open This Schedule to All Shared Users’ box. To find UCS Client Schedules

available, click on all selections: Presence, Organization, Logs and Phone windows in the main
window or Search Shared User window.

To view other UCS Client user schedules:
1. Right-click on a contact’s schedule.

2. Select Schedule Info; the Schedule Info window will display.

7 schedule Inlo

I T 3 4
5 6 F B 9 1011
13 13 14 15 16 IF 18
I'Im.ll 3 3 IS
25 27 18 29 30

3. Select the month to view by navigating forward and backward from the current position using
the arrow buttons in the upper-left part of the window.

4. Select a date in the mini-calendar on the left side.
5. Click on the schedule to view the schedule details.

6. Click OK to close the window after viewing the schedule.
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Chapter 10
ICR (Individual Call Routing) Window — (P)

With iPECS UCS Client, you can establish scenarios to route incoming calls. Each scenario
defines rules to route incoming calls, time, day of week, date and caller ID to a destination you
define. Up to 10 scenarios can be established using the UCS Client ICR Wizard and the
relative priority of each can be set. You can select another UCS Client user as an Agent, who
is then able to view and modify your scenarios. When an incoming call is received, the iPECS
notifies the UCS Server, which queries your ICR scenarios. iPECS UCS Server will compare
the incoming call parameters to those of the scenarios. The call is then routed to the
destination in the matching scenario with the highest priority.

U] ICA Scenario List @

efresh Agenl efres] ave | |= [ v Agen
%) Refresh agent | [J Refresh 5 =} Add Edit CPWD My Agent
C ndex cenario Name omment| Holiday Schedule
[E] Myself Act [ Ind S i M C t| Holiday Schedul
1 Scenario (2008-03-21 08:28:58) Effective X =
2 Scenario (2008-03-21 08:29:14)  Effective ¥ E4

Iy Agent - <Empty > L] L]

ScCenario Surnmmary

Caller ID Date & Time Destination

Al call 2008-03-21~2099-12-31 CIFTFIIIIIET
17:50:01~23,59:59
MOM, TUE, WED, THU, FRI, SAT.

The ICR Scenario window consists of three (3) major components: the User list on the left the
Scenario and Summary screen on the right and the ICR icon tools at the top.

To access the ICR window:
1. Click Set My Phone Status from the File menu or the Phone status icon from the main window

2. Select Call Forward (ICR) from the menu.

-
o

B0 ped 0 EBESO EBR0 9940

Clear
DMD
Call Forward(Simple)
Call Forward{Remote)
Call Forward{ICR} =

w

The following sections discuss how to establish and activate ICR scenarios.
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10.1 ICR User List

The User list, left side of the window, displays a list of scenarios accessible by you. In addition
to your own scenarios (default=Myself), you may be the registered as an Agent for other UCS
users which permits you access to their scenarios. Selecting a user from the list displays the
corresponding scenarios.

[T} L= Srclea Soruario Hame L oaarerd ooy hedie
[1E] = . . ¥
= s K
s dhgern - cLmgiy > - "
SO e

e 1D Dot s Tt [Destinabon B Prends Conaiton

NOTE

The icon represents your scenario list and the icon represents scenarios of users that
registered you as an agent.

10.2 Scenario & Summary Screen

The Scenario & Summary window is a list of scenarios for the selected user and a summary of
the call parameters for the scenario. In this screen, the priority of the scenario can be adjusted
with the up/down arrows. The scenario listing includes:

* Act — check box shows the status of the scenario (checked is active).
* Index — defines the priority of the scenario.
* Scenario Name — name assigned to the scenario.
* Comment — timing status of the scenario:
— Effective — timing of scenario is active or future,
— Expired - timing of scenario has expired.
* Holiday — indicates the scenario is for a holiday schedule.
* Schedule —indicates the scenario is from your schedule

The Scenario Summary at the lower part of the window displays the call parameters for the
highlighted scenario:

* Caller ID — Caller ID or Phone number that applies to the scenario.
* Date & Time — the day, date and time to apply the scenario.

* Destination — the destination User ID or Phone number.
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10.3

10.4

* IM Presence Condition — the IM presence state that applies to the scenario.

To adjust the priority of a scenario:
Select a scenario in the list.

Select Up/Down arrows to move the scenario in the list.

Act Index | Scenario Mame Comment Holiday Schedule
1 Scenario (2008-03-21 03:28:58) Effeckive X b3
z Scenario (2008-03-21 03:29:14)  Effeckive ¥ b3

Click Save to store the new priorities.

ICR Icon Tools

The ICR tools are used to manage the User Scenarios. Icons refresh the ICR window and
save, add, or edit scenarios. Using the CFWD icon, you can forward your traditional iPECS
terminal using a scenario. Finally, with the My Agent icon, you can register or delete Agent
definitions. The following list identifies the icons, and provides a reference for more detailed
information on operation of the icons (as applicable).

(U} ICR Scenario List

E:J Refresh Agent [:J Refresh B Save E‘i_.ﬂdd @\Edit (f} CFWD @ My Agent

B Myself Act  Index | Scenario Mame Comment Holiday Schedule
£ UCS Lser 2 1 Scenatio (2008-03-21 05:28:58) Effective X kS
z Scenario (Z2008-03-21 08:29:14)  Effective ko

* [ 0 Refresh agert | refreshes the user list (refer to Section 10.1).

e [ refresh| refreshes the displayed scenario list.

* |3 sa=| saves the scenario.

* | [E | adds a new scenario (refer to section 10.4).

o | [E.edt | edits the selected scenario (refer to section 10.4).

» [# crwp| activates ICR Call Forward for the user's iPECS terminal (refer to section 10.5).

 |[E myacent| registers or deletes agent (refer to section 10.6).

ICR Wizard

The ICR Wizard guides you through setting the parameters for a scenario. In the wizard, you
will assign a name, the Caller IDs that apply to the scenario, the scenario timing and the
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destination(s) to receive the call.

(Y] ICR Scenario List

;] Refresh Agent | [;] Refresh | [ Save | E"_ Add] @Edit
[E Myself Ak Index | Scenario Name
7 UCS User 2 1 Scenario (Z008-03-21 05:2¢

N

Ll =

To access the wizard, select Add or Edit from the ICR Scenario List window or select from the
popup Scenario menu (refer to Section 10.7).

) ICR Wizard X

= ScenarioMame | Scenario (2012-04-29 2 547:25) |

= Target User

= Caller ID @ tllcal
(O Select Callis)
Selected Callis) Delete
HMame Phone humber -~
LIK11063
LIk11064 0
LIE11065 v

Call Mumber to Add
‘ | [ Add ] [ Search

» Time Condition (& OFfice Hour(09:00:00 ~ 18:00:00)
(O Before Office Hour{00:00:00 ~ 09:00:00)
(O After Office Hour(18:00:00 ~ 23:59:59)
(O Holiday or Weskend

(O Select Time
Selected Time
Add
= IMPresence (@ Al M Status
Condition
() Selected IM Status
= Destination
(&) Select Callis)
Type  Station
Selected Calls) ‘12345\ | | Search ]

OK Cancel

10.4.1 Entering a Scenario Name

A Scenario Name with the current date and time is automatically generated when Add is
selected. The name can be modified at any time.

To add scenario name:
1. Enter a name in the Scenario Name box.

* Targek User
e
« Caler ID @ Alcal
© Select Calls)
Selectod Cobs)
Nawmer Phone Rumber

10.4.2 Defining the Scenario Caller ID

Each Scenario applies to all calls, only calls from specific Callers, or another UCS Client. Your
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Private directory or the UCS Shared directory can be searched to select callers, or you may
directly enter Caller IDs that are subject to the Scenario routing.

UICR Wizard
* Targut Liser
* Sonanio Name Scanisrio [S000-04-14 174600
* Caler ID @ Al el
() Select Calls)
Selected Cabls)
Hame Phons Mumber
Call hhanber to Add

To apply the Scenario to all calls:
1. Select the All call button.

To search both the Presence and Shared directory:
1. Select the Select Call(s) button.

(U1 1CR Wizard

= Target User
* Scenaria Mame Sceriario (20060515 09:42: 18)
* Caller 1D Cldes
=) Seflect Calish
Salected Cals) Delete
Hame e Humbeer

A5 Ligar 2

[FTR— o

2. Click on the Spyglass search icon; the Select Member window displays.

3. Select members to add.

4. Click OK to add the member.

To enter a specific number:
1. Enter a number in the Call Number to Add box.

2. Select the Add icon to add the number to the Caller Id list.

[T IER Wizard

» Target Lsar
= Scenario Nome | Scerns (200605 |5 09:43:08)
= Coler ID ) aleal

(5) Selact Cabz)

Selected Cals)

Hame Phone Mumber
LACS Uer 2
Mo e maton

T o ]

To remove a Caller ID from the list:
1. Highlight the desired Caller Id(s) by clicking on each.

2. Select the Delete icon.
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UICA Wizard

* Target User
= ScenarioNome | Scenano (20050515 09:43:15)
= Caller 10 O alcal
(®) Select Cabiz}
Mare Fhone hurb
UCS Lser 2
Call Burber to Add add | [ CL Semch

10.4.3 Setting the Scenario Timing

You can specify a period (day, date, and time) when a Scenario will be effective. You may

select from several pre-defined periods, Work, Off Time, Holiday or Weekend, or define a timing
specific to the scenario.

To set Scenario timing:

Select one of the predefined times or select Time and click Add button.

(THCR Wizand

* Srana e Scerarn (20120423 38 247:25)

(=raacal
7 Sebart Calz)
Selected Cal(s)

Flame Prore Fumber &

Coll Nurrber 10 Al

Lk () o Ponur{ 900000 == LIE0N0)
) Bekore Offios Four (000000 - £ 00:00)
() Afver Offics Heur 180000 ~ 23:59:59)
") Holday o Wishard
7} Selact T
St Tire:
= M Preiarcn
<Zondiiion
= Destination
5} Seboct ol
Type | Statirs

Selecied Calls} | 12345

2. Select the desired start and end times; check the days of the week for the scenario and select
a start and end date.

) Time Setting

= Start: Time | RFARAA z = End Time |23:59:59
= Day [Jtue [Jwed [JThu []Fri
= Start Date | [ f = EndDate | [ J
0K Cancel

3. Select OK to save update.

10.4.4 Setting the IM Presence Condition

You can specify the IM Presence when a Scenario will be effective. You may make a scenario
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10.4.5

active regardless of IM Presence or select an IM Presence, Offline, Online, Busy, Away, Be

Right Back, Out of Office or In a Meeting.

To apply the IM Status to a Scenario:

. Select the All IM Status button.

To apply the Scenario to a specific IM Status:
. Select the Selected IM Status button.

. Select an IM Presence (Offline, Online, Busy, Away, Be Right Back, Out of Office or In a
Meeting) from drop-down Type menu.

Assigning a Scenario Destination

The Destination area establishes the routing of calls that meet the parameters of the scenario.
Destinations include your cellular phone, home phone or office phone already registered.
Additionally, your Private directory or the UCS Shared directories can be searched or you may

directly enter a destination to receive the call.

To search either the Private or UCS Shared directory:

[U1ICA Wizard ]

= Target Liver
= Sceric Mave

= Calle 1D

& Time: Conalitun

= [M Prvsmnon
Coneition

. Click the Select Call(s) button.

Loenatio (201 2-09- 39 20 34705}

.80 call
Selact Call(s)
St Sl

Coall Rrritenw b ]

w10 Face: Piour (D000 001 - 1000008}
Befiore Office Fowe] 0 D vinl ~ 05 00rH0H

Fokday or Weskord
Saelect Tres
Sebstted Time

Tyew |Saben

Sebscted Cols) (12345

i Cancel

. Click to Select User from the drop-down Type menu.

. Click Search.

. Select a destination from the Select Member window.

To enter a specific destination:

. Check the Select Call(s) button.

98

iPECS UCS Client for PC User Guide - Issue 4.1



2. Select a Type (Station, Hunt group, Offnet) from drop-down Type menu; a specific Hunt group
can be selected from the list.

3. Enter the appropriate number in the Selected Call(s) box.

4. Click OK to save the new or modified scenario(s).

= Destination My Cellular Phone(777-7777-8555) = Destination

() My Home Phane(000-333-4444)
() My Office Phone{000-333-3333)
(&) Select Callis)

(O My Cellular Phone(777-7777-8558)
() My Home Phone(000-333-4444)
() My Office Phone(000-333-3333)

(®) Select Call(s)
Type | Station Type |HuntGroup
Selected Calls) [4578 | (12 search) Selected Call(s) [+624 (External VM Type) Search |
oK Cancel ( oK ( Cancel
= Destination My Cellular Phone(777-7777-8888) ® Destination

() My Cellular Phone(777-7777-8855)
() My Home Phone{000-333-4444)
() My Office Phone{000-333-3333)
(&) Select Call(s)

() My Home Phone(000-333-4444)
() My Office Phone{000-333-3333)
(&) Select Call{s)

Tvpe | CFfnet

Selected Call(s) ‘01023543456 | [ Saarch} Selecked Callis) | | Q Search|
0K ( Cancel ( 0K ( Cancel

10.5 Activating ICR Call Forward

Once scenarios are saved, the ICR feature can be activated to forward your calls using the

scenarios. When a call is received, to your iPECS phone the UCS Server compares the call
parameters to scenarios and routes the call appropriately.

[Tl ICA Scenario List

£ Refresh Agert | () Refresh | [F] save| [Eadd | (2, st (G2 cwo DB My agent

[ Myself Act  Index  Scenario Name Comment Holiday Schedule
€3 1CS User 2 I 2008-0 56) Effective X %
2 4) Effective

To activate the ICR Call Forward feature:
1. Inthe ICR window, select the Scenario(s) by clicking to highlight.

2. Click on the CFWD icon tool.

3. Select the Forwarding Type from the drop-down menu. Available choices include:

[V} ICR Call Forwarding

= IR Forwarding Type

Clear
Unconditional
Busy
No Answer ncel
Busy/Mo Answer
* Clear

* Unconditional
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10.6

10.7

* Busy
* No Answer

* Busy/No Answer

4. Click on the OK button activate ICR.

Using My Agent Control

You can define another UCS Client user as an Agent that can view and modify your scenarios.
You can register only one Agent, but can be the Agent for multiple other UCS Client users.

To manage Agent definitions:
Select the My Agent icon; the My Agent popup menu displays.

Select Register My Agent to assign an Agent,
OR

. Select Delete My Agent to remove your Agent.

1 ICR Scenario List

[ Refresh Agent | C}) Refresh | [ Save [Sledd —Slea £ oo

Wo | [E] My Agent
Register My &gent
[l Myself Act Index mment Holiday' Schedule
7 UCS User 2 1 5 ective X ®

2 Scenatio (2008-03-21 06:29:14)  Effective ¥ H

Scenario Menu

In addition to the ICR icon tools, the Scenario menu can access the Scenario Wizard. From

the Scenario menu, you can add, edit and delete a scenario. Adding and editing a scenario is
discussed in Section 10.4

To delete a scenario:
Right-click on a scenario in the Scenario list, the Scenario menu appears.

U] ICR Scenario List

E'.:I Refresh Agent E'.:I Refresh E Save E"_Add @\Edit

[El Myself Ack Index  Scenario Mame
7 UCS User 2 1 Scenatio (2008-03-21 0: 2i

Add
Modify

Delete

Click Delete; a confirmation window appears.

Select OK to delete the scenario.
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Chapter 11
Collaborative Session Tools

Other collaboration tools include Instant Messaging (IM), Sending files, Sharing, Web Push and
Video Conferencing. In conjunction with the Voice and Video communication, a complete
multi-media communication session involving text and graphic messages, sharing, Web Push,
and sending files can be established with the UCS Client. The tools are under the main
application Tools menu, in right click popups (Presence, Log and Call windows), and the
Selected Contact window. This section covers the use of each of the collaborative session
tools.

IM is an IP-based near real-time communication service for text information. You can create
and send a message to other UCS Client users in the IM session. Other users can create and
send responses as they desire.

An IM session can be created as a 1:1 Chatting session, or Multi Chatting session can be
established. Message dialog can be stored locally as a Rich Text Format (RTF) file.

NOTE
You must be online to initiate, be invited to, or to join an IM session.

11.1.1 Initiating 1:1 Chatting

For 1:1 Chatting, the IM window may be opened from the main window Tools menu as part of
an active call or video conference using the IM icon tool. Once an IM window is opened,
additional participants may be added using Invite from the IM menu.

File Wiew | Toals | Help o}

Caill r B0 o o

ey -2
%% ’l__ File Send P
r E | B Sharing » B
- |2 BMS

Schedule
[ AEH]

Video »

To start an IM session from the main application menu:
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1. Select IM from the Tools menu, which displays the Select Member window.

2. Select the desired members from the Member List area, and click Add to list the member in the
Added Member List.

3. Select OK to display the IM window (refer to Section 11.1.3).

To start an IM session from any of the Main, video or other windows or popup
menus:

1. Right-click on an online user; the popup menu will display.

2. Select IM from the popup menu.
= Group Mot Assigned (13}

R ucstester1? ¢ 2=
“Kell 2 Make A Call ,

Scheduled Dial

ucsi—=
¥ e

X3 File Send

m uest] (L Sharing »
Sl U e sms

11.1.2 Initiating Multi Chatting — (P)

Multi Chatting permits an IM session with multiple users, up to 100 at one time. During 1:1
Chatting, you can initiate multi chatting by dragging any user from Presence View into IM

@ ucs Client - x @ ™ _ x
File  Wiew Tools Hel
" a ucskester12 B Save X Leave Chatting
G50 ped 0 B30 B0 2d 0 ‘ 1112
r ucstester3z | 1132 .
¥ F |Fine day! . ‘ @ ™ - X
3 how are you - £ 10:30
o o Lo here - @7 10,510 ¥ ucstesterd [ save X Leave Chatting
. | bl
1133
Y 2+ B 2D Are you there - 27 10:31 ucstester3z
- 7 ucstesterd3 28 10:31 b uecstester33
B Group Not Assigned (13) B I'm here ucstester1?
— ucstester33 2 10:52
i (A Lostesteri2 - Did yau Finish the: meetig?
- Kahn Mot yet, - 27 10033
< Uestester13 o
- Good day =
hS ucstesterds L P
. - oniline >
ucstester14 2=
} - Offline
Uestester21 -
- Offline
¢ ; Ucstestara4 o
- Offline e
T

Send
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11.1.3 Initiating Multi Chatting from Chatting List — (P)

You can retrieve the chatting list created before entering a chat room by selecting any chat
room from chatting list.

[7) Chatting List

[ Refresh

Leave Chatting Chatting Mums, Members Created Time
X LeaveChatting | [ED z ucstester3z, ucstesterz 2013-10-19 09:16:46
X LleaveChatting | [ED z ucstester32, ucstester 12 2013-10-31 11:46:10
X leaveChattng | [(Z) 3 ucstester32, ucstester 33, ucstester12 2013-11-07 10:29:57

To enter a Chat Room:
1. Select the Chat Room from Chatting List.

11.1.4 IM Window Introduction

The IM window is comprised of a number of areas including icon tools, Participant List area,
message dialog area and message entry area.

D ™ — Icon Tools area

) ucstesters | [0 save X Leave Chatting

'% 1133 o )

. Participant List area
Are you there - 2 10031 ucstester3z

ucstester33 27 10:31 urstesterss

I'm here ucshesterl2
ucstester3s 2 10:32

Did yau finish the meetig?

Mok wet, - 28 10033

Message dialog area

Send Message entry area

11.1.4.1 IM Icon Tools

As with other windows, the IM window includes icon tools to place a call, start a video

conference and tools to initiate other collaborative sessions with other participants in the IM
session.
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[©] save 2 Leave Chatting

When ending a session, text from the IM message dialog can be saved locally as an RTF file.
To save an IM message dialog:

1. Select Save from the IM window.

2. Inthe File menu, select Save.

3. Inthe popup, select the location and file name.
4. Click OK to store the file.

11.1.4.2 IM Participant List

The Participant List area displays the participants in the session. You may display summary
information about individual participants.

@ ™

- X ucskester3z
» ucskesterdd
Save Leave Chaktin
ulcls;:sterSS E X " ucskeskerl?

11.1.4.3 Sending IM Messages

With the IM window displayed, you can send and receive messages.

@ ™

- X

ucstester3d E save X Leave Chatting

‘% 1133
Are you there - 8 10:31 ucstester3z

ucstester3s T8 10:31 » ucstesterss
I'm here

ucstester1z

ucstester3s 2T 10:32 @ Your Message area (Right Side)
Did vou finish the meetig?

Mot yet, - 2 10033

Other user Message (Left Side)

Send
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To send a text message:
1. Enter the desired text in the message entry area at the bottom of the IM window.

2. Click on Send to send the message to other participants.

11.1.5 IMLog

If enabled, each IM sent is stored in the IM Log. To enable the IM Log, refer to Section 3.2.3.4.
The IM Log includes the date, time, sender, and receiver(s) of the message as well as the
message text. The Log can be searched by any of the columns shown in the IM Log window.

(01 IM Log )

[ Refresh > Delete 3¢ Delete all

Date & Time From To Message
2013-11-07 23 Hi
10:29:11
2013-11-07 28
10:30:28
2013-11-07 27
10:31:04
2013-11-07 2 H
10:31:28
2013-11-07 27
10:31:53
2013-11-07 2T
10:32:53
2013-11-07 2
10:33:01

ucstester3?  ucsteskerl?

ucstester1Z ucstesterzz [1OW are you

ucstester3z  saa (A R

Ucstester1z  ucstesteraz | oM here

ucstester3  ucstestersz 1M hers

Uestesterad Orstesteriz DI ¥ou Finish the mestig

ucstester3z  aaa Mak yet.

11.2 File Send Introduction — (P)

You may send files located on your PC to other UCS Clients. Up to three files can be sent to
up to five selected UCS Clients at a time. The maximum file size that can be sent is 300MB.
The receiving UCS Clients must be online and authorize receipt of the file before the file is sent.
Received files are stored in the UCS Client PC directory defined in Setting window, refer to
Section 3.2.3.4.

11.2.1 File Send Window

The File Send window manages the transfer of files. The window includes the list of users
(maximum 5) to receive the files and the files (maximum 3) being sent. Icons allow you to add
or delete recipients and files as well as initiate or cancel a file transfer. The recipient list
includes a status display indicating the file transfer status and the percentage of each file

transferred.
(7 File Send 3]

Select Members |+ add || % Delete |
User ID Status File 1 File 2 File 3
ucusersd 0% 0% 0%

Select File | +add || X Delete |
File Name Size (Byte)
example.bxt 303

[ send || rancel |[ Close
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To access the File Send window:
1. Select File Send from the main, video or sharing windows, or various popup menus.

To send files from the File Send window:
1. Click the Add members icon.

2. Select recipients from the Select Member window (refer to Section 11.2.1.1).
3. Click the Add files icon.
4. Select files from the Browse for Folder window (refer to Section 11.2.1.2).

5. Click on Send, the File column shows the transfer status.

Status indications in the Status column are:
* Requesting — Indicates the recipient has received the request to transfer files.

* Allowed - Indicates the recipient has accepted the file transfer and the files are being sent.
* Denied — Indicates the recipient has rejected the file transfer and the files are not sent.

* Failed — Indicates no response from the recipient or an error occurred

* Completed — Indicates the file transfer has been completed.

* Canceled — Indicates the recipient has rejected the file transfer.

11.2.1.1 Adding Member Recipients

When you select the Add member icon, the ‘Select Member’ window displays. From this
window, you may select members to receive files. A user must be online to be selected as a
recipient.

To select users to receive files:
1. Select recipients from the Member List.

Select Member

Mermbier (it + Add

Lo 1D [T Dimekbengs Phucsrn

Added Member List 3 Dudste

e 10 e

(i3 Cancel

2. Click on Add to move members to the Added Member List.

3. Click OK to add the users as recipients and return to the File Send window.
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OR

4. Recipients can also be added by selecting them from a main window then drag and drop them
to the Select Members list in the File Send window.

11.2.1.2 Adding Files to Send

When you select the Add files icon, the Open file window displays.

From this window, you
may browse folders in the PC to locate the files you wish to send.

To select files to send:
1. Select the Add icon.

2. Browse to locate the appropriate files on your PC.

Open @@
Look in: ‘..ju:c j & £ B~
LY Apphcat\on Dits #| nkuser,dat.LOG
|[2) Conkies Mpgadmm‘\ug

MyRecent  |[(3Deskiop
Diocuments ¢ Favorites
Local Settings
|Z)My Documents
My Recent Documents
MetHood

J PrintHood
SendTa
by D i
L DREL Sl | Start Menu
— Templates
5 | NTUISER DAT
My Camputer
‘"} File: name: | j Open |
- J
My Network, Files of type: | j Cancel
Places

[ Dpen as read-only

3. Select the desired file, and click OK to add the file to be sent.
OR

Files can also be added from a directory screen by dragging and dropping to the Select File
area of the File Send window.

11.2.2 Recipient Authorization

When you select Send in the File Send window, recipients receive a popup natification that
another user is attempting to send files to them. The popup lists the name of the user
attempting to send files. The recipient may accept or reject the file transfer. If the invited
user accepts the file transfer, the File Send window displays and both the sender and receiver

see the file transfer progress. If the recipient rejects the transfer, your File Send window will
show the file transfer status as denied and files are not sent.

V) Invite Message

\’ : \ Fle Send Request from ucuser3(UCS Usar, .,

Do you wish to join?
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11.2.3

Opening Received File

When files are received, they are stored in the directory defined under Section 3.2.3.4. The files
can be opened immediately from the File Receive popup, using the normal PC file open
sequence or from the UCS Client File menu:

. Select Open Received Files from the File menu.

Double click on the desired file.

Fim \k Vi Fovorws Tock  Help l‘_I-TI ucs EIiEI’It

Saswch Fuiders.

-
|

o ¢ N’\;qmFles\i\.cS Chers Wrecenedle v EYe | File | Wiew  Tools HEID

Logout

| Open Received Files |

Set My Presence 4
Set My Phone Status »

My Information
Setting

Close

The application sharing function permits iPECS UCS Clients to share the information displayed
in the Sharing Master Page with up to five (5) other UCS Client users. You can share
documents, spreadsheets, presentations and drawings in real-time. The initiator or master
maintains control of the shared material and can edit the material, which is immediately shown
to other UCS Clients in the sharing session. The master can pass control to another user in
the session, permitting the new master full session control.

Once the sharing session begins, any information that may appear in the master’s Sharing
window, such as an incoming call popup, will be displayed to other users depending on sharing
options, see Section 3.2.3.4. To participate in a sharing session the user must be online.

NOTE

The ‘Any windows’ selection in the Application Sharing window must be enabled to share a
browser in the Sharing window, see Section 3.2.3.4. As you move the browser window to the
Sharing Master Page, other users in the sharing session see the web page.

11.3.1 Application Sharing Window

The Sharing Master Page window manages the Application Sharing function. At the top of the
window is the sharing participant list with the controlling participant indicated by the marked
radial button. Icon tools are provided to add participants and files as well as to start and stop
the sharing session. The master can call and initiate other collaborative sessions with a
selected patrticipant by selecting from the ‘Others’ tool menu.
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(¥l Sharing Master Page

é 6 + Ucuserl
Master (Selected)

l Display Size I { Start J l Stop J Emrs ] “
(% Make & Call
M
53 File Send
e Web Push
®  Video
4 SMSE
2 Email

To initiate an Application Sharing session:
1. Open the Sharing Master Page by selecting Application Sharing from any of the main, video
or other windows or popup menus.

2. Select participants for the sharing session (refer to Section 11.3.1.1).
3. Selectfiles to be shared (refer to Section 11.3.1.2).
4. Click on Start to begin the session; this will send an invite message to the selected participants.

5. Ifthe invitation is accepted, files are shared in the Participant Application Sharing window (refer
to Section 11.3.4).

The sharing master can pass control to another participant. The participant becomes the
master and can then edit documents displayed. To change control to another participant, click
the radial button next to the participant name.

NOTE

Use One-click application sharing in the Tools menu (IM/Video/Call Tab), by clicking on the
desired Tools menu item; a sharing session will begin with the selected contact and item.

11.3.1.1 Adding Application Sharing Session Participants
Selecting the Add member icon from the Application Sharing window, opens the Select Member
window. From this window, you can select up to five other participants for the session. A
user must be online to be selected as a participant.

[U) Sharing Master Page|

Is = * ) ousar |
| Master

Display Size Start

To select participants:
1. Select the Add member icon (g ).

2. Select participants from the Select Member window.

3. Click OK to add the user as a file recipient and return to the Application Sharing window.

11.3.1.2 Adding Files to Share
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Up to five (5) files from the Open Sharing List can be shared at any one time. The master can
add and delete files from the list and multiple file types, documents, spreadsheets, slide shows,
etc., can be selected. Multiple files can be opened in the window simultaneously with the
active file displayed on the top of the screen.

(U] Sharing Master Page

Display Size Start

To select files at any time during the session:

. Click the Open (Q ) icon, the Open Sharing List opens displaying available opened and

minimized files.

. Select files to be shared from the list.

. Click on OK to accept the change.

Additional files can be added to the list from the Open Sharing List window.

To select other documents:

. Click on the Open New Selection List.

Open EJE'
Lok ir: |@ Desktop j L cf B2~

L J—_]My Documents
|_~}$ j My Camputer
My Recent | &Juy Network Places
Documents (J)capturesnap32
@ (ChImage_capture
[(IMew Folder

Desklop (] Mew Text Document bt

My Diocuments
=1
58
by Computer
-:'] File: narne: “ j l&l
N
My Metwork  Files of type: |Document files =l Cancel

Pl
anes ™ Open az read-only

. Select the document type, Document or Paint Board can be selected. Selecting Paint Board

opens a blank paint file. If Document is selected, the Open window displays.

From the Open window, browse folders in the PC to select files to share.

. Select the desired file(s).

. Click OK to add the file to the Sharing List.

Certain types of files such as Internet browsers may not be recognized by the sharing module
as applicable to sharing. In this case, selecting ‘Any Windows in the Shared window’ allows a
window to be dragged to the Sharing window for display to participants, see Section 3.2.3.4.

NOTE
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Modifying the ‘Any Windows in the Shared window’ setting will not affect an active sharing
session. To allow sharing all windows, you must terminate the active session and restart the
sharing function.

11.3.2 Application Sharing Participant Window

When the initiator (Master) begins a sharing session by selecting Start, selected participants
receive the Invite Message popup. The invited user may then select Yes to join the session or
reject the invitation by selecting No.

(V) Inyite Message @

1 Application Sharing Reguest from Lcuser2 (Lc user2)
Do you wish to join?

Tes MNo

If the user selects Yes to join the session, the Sharing Participant window displays. This page
displays the Member List at the top of the window. The radial buttons in the master’s window
indicates the controlling party. The window displays the active shared file shown in the
master’s window.

[V} Sharing Slave Page

Rop
-]

int - [UCS Training(Intro-080414).ppt] i@r 1
Format  Tools  SlideShow  Window  Help , B

A - | i Design | New Siide &8

UCS

i Unified Communication Solution

At any time, a participant can leave the sharing session by selecting Stop in the upper right
corner of the window.

11.3.3 Other Participant Tools

The window includes icon tools so the participant can call and initiate other collaborative
sessions with a selected participant by selecting the appropriate icon tool.

(Y] Sharing Slave Page

Member List (=) ucuser3 ucuserl

.@@E-»QQ

‘eb Push
SMS
Ernail
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11.3.4

Drawing in Program Sharing mode

Drawing tools are included for creating drawings such as free-form lines.

During an

application sharing session, clicking one of the Drawing mode icons next to the Others button

selects a drawing activity.

(U] Sharing Master Page

= ucuserl
o ° Master

(Selected)

[ Display Size H Start “ Stop ]l

Others

. : sets color

: sets line width

. |i| : free-form line
i |S| : straight line
. (O] :ellipse

. |E| : rectangle

« (1] : clearall

e X :Exit

: selects a picture

11.4 Web Push — (P)

Web Push service permits you to control Web Page views for other users.

In Web Push, you

send or push a Web Page address (URI) to the online UCS Client of selected users; up to five
(5) users may be selected. After the selected users accept the Web Push, their PC Web
browser opens and displays the Web page.

To push a Web page to other UCS Client users:
1. Click Web Push from any of the main, video or other windows or popup menus.

[Vl Web Push

Seleck Members

[+ Add | [ % Delete |

User ID Status
ucuser3

Marme
LiCS User 3

= LRI |htu:-:,‘f'.d\"a\w.ericssonlg.coi‘n

Send l I

Close

2. Click the Add member icon in the top right of the Web Push window.

3. Select the desired recipients (maximum 5) from the list of users displayed.

4. Enter the Web page address (URI).

5. Click Send to send the request to the recipients.
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Each recipient receives an invitation message and can accept or reject the invitation. If the

invitation is accepted, the recipient’'s web browser opens and displays the pushed Web page.
To accept the invitation, select Yes in the Invite Message popup.

[©] Invite Message E]

Web Push Request from ucuser3
] http:/fwww.ericssonlg.com
- Do you wish to join?

11.5 Video Conferencing and Broadcast — (P)

The UCS Client uses a Web Cam and application to implement real-time video communications
over an IP-based network. Two types of video conference are available, the normal mode and
the presentation mode. In the normal video conference, each member sends and receives

video from other members. Up to six (6) UCS Client users, including the initiator may be
included in a normal Video Conference.

L

Chcktosend or Stop B

In the presentation mode, the initiator broadcasts video to all members and members send
video only to the initiator. The initiator can broadcast video to 31 parties and will receive video
from all 31 members of the conference. Note that in the presentation mode, the initiator will
need a more powerful CPU to provide quality video.

To initiate a Video Conference:

1. Click Video or Video (Presentation Mode) from any of the main, video, or other windows or
popups.
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2. Click on the Add icon from the Video window to display the Select Member window.
3. Select the desired parties from the Member List.

4. Click OK; each selected party will receive a video call Invite Message popup and the inviting
party will receive the Invite Status Message. The status can be Accepted, Denied or No
response.

5. Ifthe invitation is accepted, click on Send from the Invite Status Message window to transmit
video.

6. To add additional parties, repeat steps 2 through 6.

UCS Client users without a Web Cam may be invited to a Video Conference and will receive
video from the conference, but will not send video. When receiving a video call, the invited
user receives an Invite Message:

7. Click Yes; the Video preview window will open with a preview of the PC Cam output.

8. Click Send from the preview window to transmit video.

(U] Invite Message §|

f ~ .‘ Yideo Request from ucuser3(UCS User 3
\ Do you wish to join?

¥ allow and Send video

To turn video transmission On or Off,
1. Right-click below “My image”.

2. Click on the Stop button.

The Video window displays all parties, maximum 6, in your video conference. You can display
a single party if desired. To display video from a single party in the Video Conference, double
click the video frame of the desired party.

NOTE
Resize the Video window by clicking on the lower-right corner and drag to the desired size.
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You also have access to tools to place calls or initiate other collaborative sessions with the
video session participants. lcon tools are located at the top of the Video window of the initiator
or for other participants, right click on your picture.

wiuserd
(= Makm A Call of a2
Y & o030
= File Send Gr D00-333-4804
[ Shating
§& Web Push

&= SMS

G& Send Emall

Detad kndormation

To rotate a video image:
1. Right-click on the video image.

2. Select the desired video frame rotation.

Mo Rotation
®  Rotate by 90 Degrees
Rotate by 180 Degrees

Rotate by 270 Degrees

11.5.1 Video — Remote Monitoring
A UCS Client located at a remote site can view the web camera output of another client. To
be able to monitor another client remotely, that client must be configured to allow monitoring
and the monitoring client must be configured in the list of users allowed monitoring of the client.
If the client is set for you to be monitored, the remote monitoring presence icon will be display
on the right side of the contact record in the Presence window.

To allow remote monitoring:
1. Click on the Remote Monitoring Manager from the Video menu under the Tools main menu.

(U] Bemote Monitoring Manager E|@|Pg‘

Use Wehcam Presence
Show niotification of manitoring
Allawed User List |+ oadd || X Delete |
Usger ID ame
Utuserz Ut user2
Save Close

2. Check Use Webcam Presence, and Show notification of monitoring to notify the client of
the monitoring status.
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3. Click on the Add button to add a user in the Allowed list.

4. To password protect monitoring of the client, click the Password checkbox and enter a
password.

5. Click the Save button.

To start remote monitoring:
1. Click Start a Remote Monitoring from the Video selection in various menus and popups, the
Remote Monitoring window will display.

To start recording:
1. Click the Recording button at the bottom of the Remote monitoring screen.

2. To end recording, click on the Close button in the bottom of the screen.

NOTE

The recording capacity of your PC is limited only by the amount of free space on your hard disk,
if your PC has sufficient free hard disk capacity, the recording will be saved.

To start monitoring capture:
1. Click on the Capture button at the bottom of the Remote monitor screen.

Using Remote Monitoring to manage Recorded files:
1. Select the Remote Monitoring File Manager from the Video selection of the Tools menu and
other menus, the Remote Monitoring File Manager window will display.

] Refresh X Delete | " Delete | [, File Send (57 Email & cl

Type  Date & Time File: Name size (Byte) | Wame EXT.

AVL [2009-06-10 2 11:30... |mon_0810112943_00000196.avi 1223168 |uc user2 9002
AVL [2009-06-10 2 11:43... |mon_0810114243_0000019.avi 1213952 |uc user2 900z
IPG |2009-06-10 2 11:43... |mon_0510114304_D0000196.jog 45704 |uc user2 9002
AVI [2009-06-10 27 11:43... |mon_0610114308_00000196.avi 509440 U userz 9002
IPG|2005-06-10 $F 11:43... | mon_0610114317_00000196.jng 47422 |uc user2 9002
AVL [2008-06-10 27 11:43... |mon_0610114321_00000196.avi 500224 U user2 @002
AVI [2009-06-10 27 11:43... |mon_0610114352_00000196.avi 507392 |uc userZ 900z

| Play the Selected File
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* Refresh — update the file list.

* Delete —to delete the selected file.

¢ All Delete —to delete all the files.

* File Send — send a file to other users.

* Email — send an E-mail to the selected user with the file attached.

* Call — make a call (remote monitoring of the target).

Short Message Service (SMS) allows you to send and receive text messages with other internal
IPECS system users or external SMS users. The UCS Client stores up to ten received
messages; additional new messages are ignored. Received messages are stored in the Log
window after selecting the SMS icon in the main window. There are two types of SMS, one
internal SMS and the other Fixed Line (external) SMS.

The iIPECS system must be equipped and enabled to send and receive external SMS (Fixed
Line SMS). Internal SMS is for internal users only. All terminals including UCS Clients,
IPECS Communicator and Ericsson-LG IP phones can send and receive text messages with
other iPECS system users.

(=) Internal ) Finoed Linee
Recesmer List <+ Add . Doplyb
Preskiiog Phaores Rt
1 e
S LA0E LG fand
Flease. . Attend 1305 meeting af room 3000,
Serwd

To send a text message:
1. Select SMS from the main, video or other windows or popup menus, the SMS window displays

2. Select the Internal radial button to send to other iPECS users.

OR
3. Select the Fixed Line radial button to send an external SMS.
4. Click the Add icon.

5. From the Select Member window, select desired members and click OK.
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6. Enter the message in the Message to Send area.

7. Press the Send button, the Result popup confirms transmission.

To receive a text message:
1. Click the SMS icon located in the Message and Status bar at the top of the UCS Client window.

11.7 Administrative Messages

The UCS Administrator can send administrative messages to all iPECS UCS Clients. While
online or at login, the UCS Client displays the administrative message.

|Administrator Message

IDate 2009-06-02 09:32:36

MName Administrator

Title UCS Client 2.5 Release

Content UCS Client please install the new wersion.
Questions, please contact the administrator,

11.8 Whiteboard — (P)

UCS Clients can efficiently collaborate with other clients participating in a meeting using
Whiteboard to share drawings and free-form text. The drawing function of the Whiteboard
uses lines, ellipses and rectangles to create pictures on the Whiteboard window; pictures can
be deleted and moved.

(U} whiteboard

£+ Member Load [0 Save € Others

5 ucuser 3

At the top left of the Whiteboard are the tools icons to add members and manage the file. To
the right are the drawing tools discussed below.
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To initiate a Whiteboard collaboration session:
1. Select Whiteboard from the main, video or other windows or popup menus, the Whiteboard
window will display.

2. Click the Member icon

3. From the Select Member window, select desired members and click OK. Each selected party
will receive a Whiteboard invite message popup, which they can accept, deny or ignore. The
inviting party will receive an invite status message.

4. If the invitation is accepted, click on Send in the invite status message to transmit the
Whiteboard.

5. To add additional parties, repeat steps 2through 6.

. |i| : sets the color
. E : sets line width

: select the picture drawn

. |i| : drawing free-form line
| :drawing straight line
« O] :drawing ellipse

: drawing rectangle

€/(O)

|:| : clear all
. |@| . fits the Whiteboard size to the drawing area, or zoom (hold the button down).

o T 0% zoom setting

The UCS Client users can share their desktop screen with another user. When on a call, the
user can give control of their desktop to another party on the call for drawing pictures, etc. using
the Whiteboard.

Sharing Master Page
Start Drawing Mode
Handover Contral

v Takeowver Control

Stop Desktop Sharing

NOTE

Screen capture resolution can be adjusted to improve transmission speed during Desktop
Sharing. The lower the screen resolution selected the higher operating speed.

To adjust the Screen Resolution:
1. From the main menu, select File>Setting>Functions>Sharing>Desktop Sharing > Capture
Resolution (10-100%)
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To initiate Desktop Sharing:
1. From the main screen, click Desktop Sharing, and the Select Member window will appear.

OR

2. Click Desktop Sharing from the presence popup menu; the Desktop Sharing window will
display.

3. From the Select Member window, select the desired member and click on OK.

4. Each selected party will receive a desktop sharing invite message popup, while the inviting
party will receive an invite status message. The invitation can be accepted, denied or ignored.

5. Click on the Send button from in the invite status message to transmit desktop sharing.

To initiate the drawing mode:
1. Click on Drawing Mode from the desktop sharing popup menu; the drawing tools window will
display.

. E - sets color

. |E| - sets line width

| : selects a picture

* (1| :free-form line

* [~ :straight line

: ellipse
. |E| : rectangle
. IEI : clear all

o« X :exit

To change the controlling user from the session initiator:
1. Select Handover Control/Takeover Control from the desktop sharing popup menu.
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Chapter 12
Su pplem entary Features

The UCS Client supports other supplementary features for the user’s convenience

UCS Client users can dial the phone numbers from Microsoft Outlook contact databases easily
through UCS Client. UCS incorporates a TSP (Telephony Service Provider) for Microsoft
Outlook to dial phone numbers from the Contacts through telephone systems. Users
download the TSP for UCS Client from UCS Server and install it.

NOTE
This feature is not available for 64-bit versions of the MS operation system.

To install the TSP for UCS Client:
. After login, from the main menu, select File > Setting > General > Outlook Integration.

. Click the link at the left bottom of the window, which will download the TSP installation file from
the UCS Server.

U] Setting

Server Connection
ceneral
Basic Action
Display
Sound Enable Outlock Schedule (Auto Synchr

Diszble Outiook Security Warning

Outlook Calendar Synchrenization

Outlook Integration

call Set Default Folder

Dialing Rules
Call Popup
Ring Sound
Audio

Open Synchronized Appointments to A

Woice Codec

IP Bridge
Recording Outlook Contacts Synchronization

Click ko Call Enable Outlook Contacts (Auto Synchr
Funictions
File &S] set Default Folde
Sharing
video
m
LD&P Show Synchronization Result |
wideo Presentation Mode
Click to install UCS Outlook Add-in I [ ok

Download and run the TSP installation file.

NOTE
The link does not display if you already have the TSP installed.
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To show Microsoft Outlook dialer:
1. Run Microsoft Outlook and go to Contacts.

2. Right-click on a contact and select Call Contact, which displays the Microsoft Outlook dialer.
] Contacts - Microsatt Outlook NEI—)
i File Edit View Go Tools Actions Help Type a question for help
i@ New - | S (3 X | ¥ Z¥ - | SoFind [ (@ Typea contact to find
My Contacts D | ] |Full Name Company File As Business Phore -
8 Contacts B 1
Current View Jeong, Sangl
@ Address Cards g"_]E"
© Detailed Address Cardy= o rint
@ Phone List 5§ New Task for Contact
o By Category New Journal Entry for Contact
@ By Company Link >
@ By Location ‘@ Call Contact...
() _Bv Folow-up Flag o &l Call Using Net
) Mail ¥ | Foliow Up..
j...:...j Categories...
| calendar
K| Delete
%=| contacts
Ei A | = 4 m 3
1 Item

If you cannot find the Call Contact item in the popup menu, follow this
link http://support.microsoft.com/kb/959625/ to correct the popup.

To configure and dial the Outlook Contact numbers:
1. Click the Dialing Options button to show the Dialing Options window.

2. Choose UCS Line from the Connect using line box.

Settings for speed dialing
Mame Phone number

Number

Settings for phone number formatting and dialing
[T Automatically add country code to local phone numbers

Dialing Properties...

Connect using line

[ucs Lne

V] [ Line Properties... ]

[ CK ] [ Cancel ]

3. Click OK, and in the New Call window, click Start Call.

The UCS Client will place a call to the
Contact number through the iPECS system.
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http://support.microsoft.com/kb/959625/�

Number to dial

Contact: Deong, Sanakyul Iz‘ COpen Contact
Number: (111) 222-3333 [+] [piling Properties...

[] create new Journal Entry when starting new call

Call status: On hook

Start Call End Ca Dialing Options... l

NOTE

You can check the dialed digits from LCD in UCS Client’'s Phone tab. You may need to
configure Dialing Rules for proper operation, refer to Section 3.2.3.3.
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Chapter 13
Call View & Call Control

When call is received or placed, the active Call View screen displays with various user call
controls to manage the call.

13.1 Active Call

The active Call View displays the Caller id with picture and various call control buttons including
the list below.

B nbound E'

userdd
- - 1023

L TRANS QO voicemal || Hod

\E Park (® Recording @ MUTE

Dialpad ..L Viden

* Reject/Answer/Mute Ring (incoming call pop-up)

* Dial Pad access button

* Video Call start/accept/stop
* Ringing Call transfer

* Active Call transfer

e Call hold

* Hang-up

e Call park

* Record Call

* Mute

13.2 Call Controls
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13.2.1 Call Answer/Reject

When receiving a call from others, the inbound Call View displays. You may answer the call,
press the Answer button, or reject the call, press the Reject button. If desired, the Ring signal
may be muted. You can send the call to your voicemail, press the Voicemail button. The call

can be transferred to another user or user’s voicemail or your voicemail while the call is ringing
without answering the call.

B 1nbound

user04
> - 1023

' TRans QO voicemail

AL Ansuer

S Ring Mite

13.2.1.1 Call transfer while receiving ring tone
You can transfer call while receiving ring tone as the below.
. Call transfer

Call transfer with Voicemail

Call transfer with user’s voice mail

To transfer the call

1. Clicking call transfer button (%=* ) in the call view while receiving ring tone such as second
picture.

B inbound

user(4
= - 1023

L TRans Qo Woicemail

™u Reject

A, Answer

N Ring Mute

2. The dial pad displays, dial the station number to receive the call.
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. Inbound |z|

userl4
- 1023

S Trans QO vaicemail

g" Screened Trans. g‘ Unscreened Trans.
| W Woicemail |
1 2 3
4 5 ]
7 8 9
* ] #

3. Select the type of transfer,
Screened Trans: await answer to announce the call
Unscreened Trans: hang up after selection
Voicemail: send the call to the station user’s voicemail

13.2.2 End a Call

From the active Call view, selecting the Hangup button terminates the active call.

. Inbound |Z|

userl4
- 1023

& rans QO voicemal | pp Hold

\E Park. @ Recording @ MUTE

EE S .

13.2.3 Video Call

You can start a video call while on the phone by pressing Video button.
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@ 1nbound [x]

user04
- - 1023

o TRens QO veicemal | Hold

\E Park (® Recording g.‘ MUTE

Dispad 2 o

userds {1.94 fps)

13.2.4 Call Hold

You can place the call on hold, press the Hold button, to perform another task or place a call.
While on hold, the party receives music from the iPECS system. The call may recall if held too
long. You reconnect to the call by pressing the Hold button again.

@ Inbound )
userl4
- 9 - 1023
L TRams QO voicemail | Hold

Q Park (® Recording % MUTE

o 2 o

13.2.5 Call Park — (P-UCP, S)

You can place the call in a ‘Parking Orbit’, where others can easily access the call. The call is
parked by pressing the Park button. You may then inform the desired party to access the
Parking Orbit. This feature is often used with internal paging to page the desired user.

When you park calls, the parked call message icon indicates the number of calls you have

parked. Selecting the icon displays the Parked call list, where you may reconnect to a parked
call by selecting the call.

Ul UCS Clienk
File “iew Tools Help

¥
g5 0 ES0 ENO0 240
I = [y

ot wretactart? | 1137 t
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13.2.6 Call Recording

Selecting the Record button records the call to the UCS Client directory. Note the recording
includes audio starting from when the button is selected. You can stop the recording using the
same record button.

13.2.7 Muting Your Audio

You can mute the active microphone so the connected party will not be able to hear audio from
your microphone by pressing the Microphone button.
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Chapter 14

Audio Conference Manager

The Audio Conference Manager permits the UCS client user to manage both ad hoc and

Conference room calls.

14.1 Add on Conference

Add-on Conference allows you to establish a conference and add members on an ad-hoc basis.
In addition, you may control audio from other conference members and delete members of the
conference as discussed below.

"

14.1.1 Inviting/Removing a member

Add On Conference
|station | | Invite
_ o 2
= Idle
. - 1022

=

Q

o=

=

<

c

(]

3

T

=

iz

5

& ¢ e
5{ a Record

123 ——

Invite/Remove a member
Mute a member

End the conference
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As the master, you can invite and remove conference members.

Inviting a member
» Input station number or external telephone number, then press invite button.

* |n case of station number

Station | 1023 | nvite |

* In case of external telephone number

co -| [a 0318054101 1| | Invite |

Removing a member
» Press remove button (})

14.1.2 Muting a Member — (P-UCP, S)

A master can mute a member.

Muting a member
To mute a member, press mute button ().

» To cancel the mute, press mute button again.

14.1.3 Ending the conference — (P-UCP, S)

A master can end the conference.

» To end the conference, press end button (I ).

With the UCS Client, you can establish a Conference Room, which others can join by entering
the Room. Functions available in a Conference Room are similar to those of an Add-on
Conference as discussed below.

B Conference Roon List [
3 Noozo CU) Refresh

~
100 > B

Reom

E- :; Room §7) Addcn

* Reserve / Release a room
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* Entering / Exiting a room

* Inviting / Removing a member (master only)
* Muting a member (master only)

* Changing the master (master only)

* Ending the conference (master only)

14.2.1 Reserving / Release a Room

You can reserve / release a room from the conference call list.

Reserving a Room
1. Select the Reservation button ( [&]).

10z E|I- L

103 E_L l

2. The Create room window appears allowing you to assign a password for the room. Input a
five-digit string in Password attributes, then press OK button. If a password is not required,
then, just press OK button. In case of template room, input the pre-programmed password.

¥l Create [X]

= Room Murmber 102

= Password |

[ 0K H Cancel ‘

3. Ifaroom is reserved, then the create button does not appear. Instead the enter room button
( ~ ) appears and, if selected, you will enter the room.

102 X b ™
103 EI'_ L
Releasing aroom
1. Press release button ( % ).
102 b4 ﬂ "]

103 Ell- l

2. Ifthe room has password, input the password, then press OK button. If no password, then just
press OK button.
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vl Create |X

= Room Mumber |102 |

= Password || |

[ oc [ concel |

3. Ifaroom is released, others may now reserve the room.

102 E_L i
103 E}_ k

14.2.2 Checking Members of a Template Room — (P-UCP, S)

You can check the members associated with a template room.

» Press template room check button, then the information of members is displayed.

. Conference Room:101 - Master: @ . Conference Room:101 - Master: 1022 E
% Mo za [} Refresh 1 @ 0 change master B &
- 1021
~
1a0 Xk >l S [Gtation | [1023
o @ IR
. . i Corference
= -10z2
102 R
103 = N 1de
+ & 4 &3 - 1021
104 =] [
g EL & £
=3 o
o o
05 =R 13
106 R
107 2 &
108 = b |
109 =R 13
5 110 =] [ s
3 238 3 e
z E:
G = G
5 111 2 & 5
=3 2 - .
& = L V] 2 [
5 1= ERE i 2
= =4 & = ] @ Record
=l = [ 3
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14.2.3 Entering/ Exiting aroom

Entering aroom
» If aroom is reserved, the room enter button is displayed. Press the room enter button ( ~w ).

The display after entering a room is as below.

E Conference Room:102 - Master:1022 E

4 Changs Master ‘ o

®

Station - Inyite

. 0 X
; - Corference
- lozz

Room

© 2 =

= " ] Record

|E;‘ [E room | §9 Add on

Exiting aroom
» Press the room exit button.

14.2.4 Inviting a Member

A master can invite and remove conference members.

Inviting members
» Input station number or external telephone number, then press Invite.

* |n case of station number

Station  w| 1023 Invite

* In case of external telephone number

O | |9 03130541011] Invite
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14.2.5 Muting a member — (P-UCP, S)

As the master, you can mute the audio from other members.

Muting a member
» To mute a member, press mute button ().

To cancel the mute, press mute button again.

14.2.6 Changing the master — (P-UCP, S)

As the master, you can pass control of the conference to another member.

m Conference Room:101 - Master:1022 |z|

@ E:J Change Master ,--._, ..\-.

[l Conference Use... Q@E|
Masker |10z22 Change

Mumber

Po1022
1021

14.2.7 Ending the conference — (P-UCP, S)

As the master, you can end the conference.

» To end the conference, press end button ({&)).
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Chapter 15
Visual Voicemail — (P-UCP, S)

Visual Voicemail provides the user with a graphical representation of their voice mailbox
messages, permitting simple management and interaction with (play, pause, stop, delete and
call to sender) the voicemail.

15.1 Usage for Visual Voicemaill

The Voice Mail status button in the Message and Status bar indicates your new message status
as shown in the figure below. Selecting the button will display the Visual Voice Mail window. In
the window, you may access the various controls as listed below.

() UCs Client - X

Fle ‘\iew Tools Help ¥

B4 R 0 S0 ERO a4 1
* Play / pause / stop Voicemail
* Delete Voicemail
* Save Voicemail

¢ Call to sender of Voicemail

15.1.1 Play/ Pause /Stop Voicemail

You can play/ pause/ stop voicemails in the Visual Voicemail window.

V] ¥isual Voicemail E ||-|:||r>_(|
. Delete n)"(" Delete f Call  [=L bownload > Download Yoicemail Delete
Status Date & Time Phone Mumber Download Duration {Sec)

8% |Mew 10-23 19:22:30 1008 1.6
B (Mew 10-28 19:16:25 1023 8.5
g% (Mew 10-25 19:16:01 10235 11.6
B2 | Mew 10-28 16:04:01 1008 1z.0

2

L

— bB.1
L»)(m
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>

15.1.2

15.1.3

15.1.4

>

Play voicemail
To play voicemail, click the play button ( = ).

Pause voicemail
To pause voicemail, click the pause button (/11).

Stop voicemail
To stop voicemail, click the stop button (= ).

Voicemall
You can delete voicemail from the Visual Voicemail list.
Delete voicemail

To delete voicemail, click the delete button ( * ) after selecting voicemail in the Visual
Voicemail list.

Save Voicemail
You can save voicemails to your PC hard drive.

Save voicemail

To save voicemail, click the save button ( [=1, ) after selecting voicemail in the Visual Voicemail
list.

1) Yisual Yoicemail

¥ Delete ")"(" Delete @ Call ¥ Download Yoicemail Delete

Status Date & Time Fhone Mumber Download Duration [Sec)

Call to Sender of Voicemail

You can return a call to the sender of the voicemail.

Call to sender

To call the sender, click the Call button ( 4 ) after selecting voicemail in the Visual Voicemail
list.
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Appendix
Useful

Information

This chapter discusses the GPL (General Public License) open source software used in the
UCS Client.

This following GPL (General Public License) software used in this product is subject to the GPL
License Agreements. You can obtain a copy of the GPL licenses from Ericsson-LG Enterprise
Web Site (www.ericssonlg-enterprise.com).

GPL License:

License (GPL, LGPL, MPL,

Used Open Source BSD-style)

Applied Function or Application

appweb LGPL

bash

bluez

busybox 1.8.1

dbus

dhcpced

glibc

iproute2

wpa

linux 2.6.35.7

Izo

ntpclient

openlldp

openssl

openvpn

sqlite

tcpdump

tslib

supplicant
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Apache License:

* org.apache.commons.net.ftp.FTP

* org.apache.commons.net.ftp.tftp

Ericsson-LG Enterprise offers to provide source code to you on CD-ROM for a charge covering
the cost of performing such distribution, such as the cost of media, shipping and handling upon
e-mail request to Ericsson-LG at.: opensource@ericssonlg.com.

This offer is valid for a period of three (3) years from the date of the distribution of this product
by Ericsson-LG Enterprise.
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